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คำนำคำนำ

PREFACE
        หลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศักราช ๒๕๕๑ มุ่งพัฒนาผู้เรียน ให้เป็นคนดี   มีปัญญา  มีความสุข มีศักยภา

	 หลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศักราช ๒๕๕๑ มุ่งพัฒนาผู้เรียน 

ให้เป็นคนดี   มีปัญญา     มีความสุข มีศักยภาพในการศึกษาต่อ และประกอบอาชีพ

ในการศึกษาต่อและประกอบอาชีพ จุดมุ่งหมายหนึ่งที่กำหนดให้เกิดกับผู้เรียน 

เมื่อจบการศึกษาขั้นพื้นฐาน  คือ  มีความรู้ อันเป็นสากลและมีความสามารถในการสื่อสาร   

การคิด การแก้ปัญหา  การใช้เทคโนโลยี  และมีทักษะชีวิต      
 

         ความคิดริเร่ิมสร้างสรรค์   เป็นความสามารถในการมองเห็นความสัมพันธ์ ของส่ิงต่างๆ 

โดยมีส่ิงเร้าเป็นตัวกระตุ้น   ทำให้เกิดความคิดใหม่ต่อเน่ืองกัน   ซ่ึงความคิดสร้างสรรค์ 

ประกอบด้วย ความคล่องในการคิด ความคิดยืดหยุ่น และความคิดท่ีเป็นของตนเอง  

โดยเฉพาะหรือเรียกว่าความคิดสร้างสรรค์น่ันเอง  ท้ังน้ีเทคโนโลยีเป็นส่ิงหน่ึงท่ีได้นำความรู้ 

ทักษะ และทรัพยากร มาสร้างส่ิงของเคร่ืองใช้ หรือวิธีการ โดยผ่านกระบวนการเพ่ือแก้ปัญหา 

สนองความต้องการ หรือเพ่ิมความสามารถของการทำงานของมนุษย์  

        โปรแกรม Pro/ENGINEER เป็นโปรแกรมคอมพิวเตอร์ ที่ใช้สอนในเรื่องการออกแบบ 

และการสร้างงานมิติที่มีความละเอียดซับซ้อนที่สมบูรณ์แบบ  โดยสามารถนำมาใช้ในการ 

สร้างชิ้นงานที่เกิดจากการออกแบบด้วยความคิดสร้างสรรค์ของผู้เรียน เป็นภาพสามมิติ 

เสมือนจริง  หากนักเรียนได้เรียนรู้อย่างเข้าใจและฝึกทักษะการใช้เครื่องมือต่างๆ ในโปรแกรม 

จนชำนาญแล้ว สามารถที่จะใช้เป็นแนวทางในการประกอบอาชีพนักออกแบบผลิตภัณฑ์ได ้

ในอนาคต 



 

       สำนักงานคณะกรรมการการศึกษาขั้นพื้นฐาน  ขอขอบคุณ บริษัทพาราเมตริกเทคโนโลย ี

คอร์เปอเรชั่น จำกัด (Parametic Technology Corperation : PTC) ที่สนับสนุนโปรแกรม  

Pro/ENGINEER  ให้นักเรียนได้เรียนรู้ และฝึกประสบการณ์ ขอขอบคุณคณะทำงาน  และผู้เกี่ยวข้อง 

ทุกฝ่ายที่มีส่วนช่วยให้เอกสารชุดนี้สำเร็จลงด้วยดี หวังเป็นอย่างยิ่งว่าจะเป็นประโยชน์สำหรับครูผู้สอน 

ที่จะใช้พัฒนาตนเอง  ด้านการใช้โปรแกรม  Pro/ENGINEER  และถ่ายทอดเทคนิคกระบวนการ 

ให้นักเรียนได้ฝึกคิดสร้างสรรค์  สู่การออกแบบและสร้างสรรค์ผลงานผลิตภัณฑ์ที่เป็นรูปธรรมต่อไป

        				      	              คุณหญิงกษมา  วรวรรณ ณ อยุธยา

  				                    เลขาธิการคณะกรรมการการศึกษาขั้นพื้นฐาน

                      				                    ตุลาคม 2552
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บทที่

Chapter

1
ความเป็นมาโปรแกรม  

        โครงการหนึ่งอำเภอ หนึ่งโรงเรียนในฝัน ได้นำโปรแกรม 

Pro/Desktop ซึ่งได้รับบริจาคจาก บริษัทพาราเมตริกเทคโนโลยี 

คอร์เปอเรชั่น จำกัด (Paramatic Technology Corperation : PTC) 

มาใช้ในการจัดการเรียนการสอนการออกแบบผลิตภัณฑ์ กลุ่มสาระ 

การงานอาชีพและเทคโนโลยีสำหรับโรงเรียนในโครงการโรงเรียนในฝัน  

รุ่นที่ 1  ตั้งแต่ปี พ.ศ. 2546   และได้กำหนดให้การใช้โปรแกรม 

Pro/Desktop ในการจัดการเรียนการสอน  เป็นตัวชี้วัดหนึ่งในการ

ประเมินเพื่อรับรองการเป็นต้นแบบโรงเรียนในฝันนอกจากลิขสิทธิ ์

โปรแกรม แล้วบริษัท PTC ยังได้สนับสนุนวิทยากรจากต่างประเทศ 

ในการ อบรมวิทยากรหลักด้วย จากนั้นโครงการฯ ได้ดำเนินการ 

จัดทำคู่มือการใช้งานโปรแกรมพัฒนาบุคลากร ครูโรงเรียน  Fast Track  

จำนวน 100 โรงเรียน และมอบหมายให้โรงเรียนดังกล่าวเป็นพี่เลี้ยง

ในการจัดการเรียนการสอน การออกแบบผลิตภัณฑ์ ด้วยโปรแกรม 

Pro/Desktop ให้กับโรงเรียนที่สนใจที่ตั้งอยู่ภายในจังหวัดนั้น ๆ  

	 ต่อมาในปี พ.ศ. 2552 บริษัท PTC  ได้มอบโปรแกรม 

Pro/ENGINEER    ซึ่งเป็นโปรแกรมประเภทเดียวกับโปรแกรม 

- การเตรียมความพร้อม

- เงื่อนไขการติดตั้งโปรแกรม

- การลงทะเบียนโปรแกรม Pro/ENGINEER

- การติดตั้งโปรแกรม Pro/ENGINEER

และการเตรียมการใช้งาน



ออกแบบผลิตภัณฑ์ที่มีความซับซ้อนมากกว่า ซึ่งจะช่วยให้ผู้เรียนสามารถออกแบบผลิตภัณฑ์ได้หลากหลาย

ซับซ้อนมากขึ้น เหมาะสำหรับการจัดการเรียนการสอนในระดับมัธยมศึกษาตอนปลายและอาชีวศึกษา  

ทางโครงการฯจึงพัฒนาวิทยากรหลัก โดยคัดเลือกศึกษานิเทศก์และครูผู้มีความชำนาญและเคยใช้ 

โปรแกรม Pro/DESKTOP  เข้ารับการอบรมกับวิทยากรจากบริษัท  หลังการอบรมได้จัดทำคู่มือการใช้งาน 

โปรแกรม Pro/ENGINEER  เพื่อให้โรงเรียนในโครงการฯ ได้นำไปประกอบในการจัดการเรียนการสอน  

คู่มือดังกล่าวได้ผ่านการทดลองใช้กับโรงเรียนในโครงการ ที่เป็นศูนย์พัฒนาการเรียนการสอนการงาน

อาชีพและเทคโนโลยี เปิดสอนระดับมัธยมศึกษาตอนปลาย และโรงเรียนในโครงการฯ ที่เปิดสอน 

ระดับอาชีวศึกษา รวม 56 โรงเรียน ส่วนโรงเรียนอื่นที่มีความต้องการนำโปรแกรม Pro/ENGINEER ไปใช้

ในการจัดการเรียนการสอน  สามารถสำเนาจากโรงเรียนที่มีโปรแกรมไปใช้ได้โดยไม่เสียค่าใช้จ่าย  

และหากต้องการเปรียบเทียบความสามารถ  ของทั้งสองโปรแกรมสามารถดูได้ที่เว็บไซต ์

http://www.cadinschools.org/page.php?m=133 

การเตรียมความพร้อมด้าน Hardware และ Software

       เพื่อให้การออกแบบผลิตภัณฑ์ด้วยโปรแกรม Pro/ENGINEER เป็นไปอย่างมีประสิทธิภาพ  

 มีข้อแนะนำเกี่ยวกับการเตรียมความพร้อมด้าน Hardware และ Software  ดังนี้

ลำดับที่ รายการ ขั้นต่ำ แนะนำ

1. Main Memory 256 MB 1024 MB or higher

2. Available Disk Space 2.0 GB 3.0 GB or higher

3. Swap Space 500 MB 2048 MB or higher

2
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ลำดับที่ รายการ ขั้นต่ำ แนะนำ

4 CPU speed 500 MHz 2.4 GHz or higher

5 Operating System Microsoft Windows XP 32 bit  , Vista 32 bit

6 Internal Browser Support Microsoft Internet Explorer 6.0 (SP1 or later)

7 Monitor
1024 x 768 (or higher) resolution support with 24-bit 

or greater colour

8 Network Microsoft TCP/IP Ethernet Network Adapter

9 Mouse Microsoft-approved 3-button mouse

10 File systems NTFS

11 Miscellaneous CD-ROM or DVD drive

เงื่อนไขการติดตั้งโปรแกรม

1. โปรแกรม Pro/ENGINEER  ต้องใช้ Account เพื่อใช้ในการติดตั้ง โดยจะต้องสมัคร 

ผ่านเว็บไซต์ของบริษัท  http://www.pct.com 

2. การติดตั้งจะต้องเชื่อมต่ออินเทอร์เน็ต



4

การลงทะเบียนโปรแกรม

1.  เปิดเว็บเบราเซอร์ เช่น Internet Explorer จากนั้น พิมพ์ชื่อเว็บไซต์ www.ptc.com ที่ช่อง Address 

2.  เมื่อเข้าสู่เว็บไซต์ www.ptc.com แล้ว ให้คลิกที่แท็บ Login  

 

3.  จากหน้าของ PTC.com : Log In  สร้าง Account ใหม่ โดยคลิกที่ Create a PTC.com Account
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4.  ป้อนข้อมูลที่เป็นความจริง ในช่องว่าง โดยเฉพาะอย่างยิ่ง E-Mail address และ Password 

เพื่อการติดต่อกับ PTC.com เมื่อกรอกข้อมูลครบแล้ว คลิกปุ่ม Create Account

โปรแกรมจะกำหนด E -Mail address  ให้เป็น Username ต่อไป
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การติดตั้งโปรแกรม

โปรแกรม Pro/ENGINEER บรรจุอยู่ในแผ่นซีดี Installation DISC1 และ DISC 2 

การติดตั้งโปรแกรมดำเนินการ ดังนี้   

1.ใส่แผ่น Installation DISC1 (CD 1 of 2) เข้าไปเครื่องอ่านแผ่นซีดี จากนั้นโปรแกรมจะเปิด

อัตโนมัติ (Auto Run)  หากเครื่องใดตั้งค่าไม่ให้ Auto Run ทำงาน ให้ ดับเบิลคลิกที่ไฟล์ Setup.exe 

ในแผ่นซีดี จะปรากฏผลดังรูป

จากนั้นในหัวข้อ Select your Language  

ให้คลิกเลือกภาษา English คลิกปุ่ม Next >
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2.  คลิกปุ่ม Install Now  ในหน้าต่างถัดมา แล้วรอสักครู่ 

3.  คลิกปุ่ม Next > เพื่อเริ่มต้นการติดตั้ง
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4. คลิกตัวเลือก Accept the Agreement Terms and Conditions ดังรูปด้านล่างจากนั้นคลิกปุ่ม Next >

5.  คลิกที่ลิงก์ Pro/ENGINEER เพื่อเข้าสู่การติดตั้งโปรแกรม 
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6. ดำเนินการสร้าง License ผ่านระบบเครือข่ายอินเทอร์เน็ต โดยคลิกที่ปุ่ม Generate License File 

ในตัวเลือก A หัวข้อ License Configuration (ดังนั้นเครื่องทุกเครื่องที่จะทำการติดตั้ง จะต้องสามารถ 

ต่ออินเทอร์เน็ตได้ในระหว่างทำการติดตั้ง)

7.  พิมพ์ User name และ  

Password ที่ได้จากการ 

ลงทะเบียนไว้ก่อนหน้านี้ 

จากนั้นคลิกที่ปุ่ม OK 

(หากยังไม่ได้ทำการลงทะเบียน

ลงทะเบียนมาใช้ในการติดตั้ง)

โปรแกรมไว้ให้กลับไปทำการลงทะเบียนให้เสร็จ แล้วนำข้อมูลจากการ

อนึ่ง ท่านสามารถใช้ User Name และ Password ที่ทาง 

โครงการโรงเรียนในฝันได้ทำการลงทะเบียนไว้แล้วคือ 

User Name : proengineer@labschools.com  และ 

Password : 123456  โดยไม่ต้องลงทะเบียนใหม่ แต่ต้อง 

เชื่อมต่ออินเทอร์เน็ตในขณะติดตั้งโปรแกรม
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8. หลังจากลงทะเบียนสร้าง License แล้ว  โปรแกรมจะติดต่อกับทาง PTC เพื่อสร้างไฟล์ License  

แล้วส่งเข้ามาเก็บไว้ในเครื่องคอมพิวเตอร์ให้โดยอัตโนมัติ โดย License จะถูกป้อนเก็บที่ช่อง License File 

Path ในตัวเลือก B จากนั้นคลิกปุ่ม Next

หมายเหต ุ: ในกรณีที่โรงเรียนติดตั้งโปรแกรมป้องกันการเขียนข้อมูล 

บน Drive C: โปรแกรมจะไม่สามารถสร้างแฟ้ม ข้อมูลชั่วคราวสำหรับ

การติดตั้งได้  ในกรณีนี้จะต้องเปลี่ยนตำแหน่งการสร้างแฟ้มข้อมูล

ดังกล่าว ดังภาพ
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9.  เราอาจใช้ตำแหน่งปกติในการติดตั้งโปรแกรม โดยการ คลิกปุ่ม Next > หรือเปลี่ยนโฟลเดอร์ในการเก็บ 

โปรแกรมได้ที่หัวข้อ Destination Folder

10. กำหนดหน่วยวัด ให้เลือกตามค่ามาตรฐานที่โปรแกรมกำหนดไว้เป็นระบบMetric 
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11.  กำหนดตำแหน่งของการติดตั้ง Shortcut  โดยการคลิกเครื่องหมาย       จากนั้นคลิกปุ่ม Install   

ก็จะเป็นขั้นตอนของการสำเนาไฟล์ลงในเครื่อง ซึ่งจะใช้เวลาค่อนข้างนาน
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12.  เมื่อปรากฏข้อความ  Please insert CDROM Number 2 ให้เปลี่ยนแผ่นซีดี จาก DISC1 

 เป็นแผ่น DISC2  จากนั้นคลิกปุ่ม OK

13.  เมื่อปรากฏหน้าต่าง ข้อความ  Please insert CDROM Number 1 ให้เปลี่ยนแผ่นซีดี จากDISC2 

เป็นแผ่น DISC1 จากนั้นคลิกปุ่ม OK

14.  เมื่อปรากฏข้อความ Installation Complete ให้คลิกปุ่ม Next > ตามด้วยการ คลิกปุ่ม Exit  

เมื่อปรากฏหน้าต่าง Exit PTC.Setup ให้คลิกปุ่ม Yes เพื่อยืนยันการสิ้นสุดการติดตั้งโปรแกรม 



บทที่

Chapter

2
การใช้งาน 

- ภาพรวมการใช้งาน Pro/ENGINEER  

- การเปิดใช้งาน Pro/ENGINEER  

- เครื่องมือของ Pro/ENGINEER

ภาพรวมการใช้งาน
Schools Edition

	 โดยภาพรวมของการใช้งานโปรแกรม Pro/ENGINEER  

Wirefire  4.0  Schools Edition มี  6 ขั้นตอนดังต่อไปนี้

	 1. ออกแบบและวิเคราะห์ส่วนประกอบของงาน  ตัวอย่าง 

เช่น ชิ้นงานเป็นชุดกาแฟ ประกอบด้วยชิ้นส่วน 2 ชิ้น คือ 

ถ้วยและจานรอง (ในขั้นตอนนี้อาจมีความจำเป็นที่จะต้องร่างภาพ 

ในกระดาษพร้อมทั้งกำหนดมิติความกว้าง ยาวและหนา ของชิ้นงาน)
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2. สร้างโฟลเดอร์เพื่อเก็บงาน

3. กำหนด Working Directory เพื่อให้โปรแกรมเก็บงานไว้ในไดเร็คทอรี่ที่กำหนดโดยอัตโนมัติ ขั้นตอนนี้

มีความจำเป็นเพราะจะช่วยอำนวยความสะดวกแก่ผู้ใช้งานในการสร้างชิ้นงาน การประกอบชิ้นงาน 

นอกจากนั้นเมื่อมีการปรับปรุงชิ้นงานจะมีการสร้างไฟล์ปรับปรุงทุกครั้งที่มีการบันทึก  โดยจะบันทึกไว้

ใน Working Directory โดยอัตโนมัติ  ทำให้สะดวกเมื่อย้ายชิ้นงานไปทำงานบนเครื่องคอมพิวเตอร์เครื่องอื่น

4. ดำเนินการสร้างชิ้นงานแต่ละชิ้น (Part) ตามที่ออกแบบไว้โดยใช้โปรแกรม 

5. ประกอบชิ้นงาน (Assembly) โดยการนำชิ้นงานแต่ละชิ้น (Part) ที่สร้างไว้เข้ามาประกอบเป็นชิ้นงาน

ตามที่ต้องการ

6. เขียนแบบแปลนชิ้นงาน (Drawing) โดยนำชิ้นงานที่สร้างสำเร็จแล้วมาสร้างเป็นแบบแปลนลายเส้น

พร้อมทั้งแสดงมิติความกว้าง ความยาว ความสูง รวมทั้งรายละเอียดอื่นๆ สำหรับใช้ในการผลิต

การเปิดใช้งาน  

	 การเปิดใช้งานโปรแกรม Pro/ENGINEER Wirefire 4.0  Schools Edition สามารถทำได้ 

2 วิธี คือ 

       1. เปิดที่ปุ่ม Start 

       2. เปิดที่ไอคอนของโปรแกรม (shortcut)  



16

การเปิดโปรแกรมที่ปุ่ม Start 
	 การเปิด Start มีขั้นตอนตามลำดับ คือ  Start > All Programs > PTC > Pro/ENGINEER 

Schools Edition > Pro/ENGINEER Schools Edition

การเปิดโปรแกรมที่ icon ที่เป็น Shortcut ของโปรแกรม 
	 ในกรณีที่มีการสร้างไอคอนทางลัด ของโปรแกรม (Shortcut) บนหน้าเดสท็อป 

ผู้ใช้สามารถเข้าใช้งานโปรแกรม Pro/ENGINEER Wirefire 4.0 Schools Edition ได้ โดยการดับเบิลคลิก

ที่ไอคอนทางลัดของโปรแกรมซึ่งมีลักษณะดังภาพ  
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เครื่องมือของโปรแกรม

	 โปรแกรม Pro/ENGINEER จะมี menu bar  เพื่อใช้เก็บคำสั่งต่างๆ เช่น คำสั่งเกี่ยวกับการ 

จัดการระบบไฟล์ต่างๆ การจัดการด้านการแสดงผล การจัดการเกี่ยวกับพารามิเตอร์ที่งานทั่วไป รวมถึง 

คำสั่งในการสร้าง Feature และอื่นๆ ซึ่งในการแสดงผลของ menu bar จะขึ้นอยู่กับการใช้งาน 

ในแต่ละ โมดูลนั้นๆ ที่ผู้ใช้เรียกใช้งานอยู่ ดังรูปตัวอย่าง

Menu Bar

	

	 เป็นการจัดเอาคำสั่งที่ใช้ในการจัดการกับโปรแกรมที่ใช้เป็นประจำมาวางในรูปแบบของไอคอน  

เพื่อให้ง่ายต่อการเรียกใช้งาน ตัวอย่างในรูปด้านล่างและรายละเอียดดังนี้

System Toolbar

Toolbar ของเมนู File

	 New			   สร้างไฟล์ใหม่

 	 Open			   เปิดไฟล์งานที่มีอยู่แล้ว

 	 Save			   บันทึกไฟล์งาน

 	 Print			   สั่งพิมพ์ไฟล์งานที่กำลังเปิดใช้อยู่

 	 Send as attachment  ส่งโมเดลไฟล์ไปยังที่อื่นๆ โดยผ่านทางอีเมล์
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Toolbar ของเมนู Edit

	

	 Undo			   ยกเลิกการกระทำที่ผ่านมา

 	 Redo			   ทำซ้ำอีกครั้งหนึ่ง

 	 Cut			   ตัด

 	 Copy			   คัดลอก

 	 Paste			   วาง

 	 Paste Special		 วางแบบพิเศษ (ใช้กับ Feature)

 	 Regenerate		  สั่งให้โปรแกรมอัพเดทโมเดลใหม่ หลังจากมีการแก้ไข

 	 Find			   ค้นหา

Toolbar ของเมนู View

	 Repaint		  สั่งให้โปรแกรมแสดงผลใหม่

 	 Display spin center	 เปิด-ปิด จุดศูนย์กลางการหมุนของโมเดล

 	 Orient mode		 เปิด-ปิด โหมดการทำงานของ Orient mode

 	 Zoom in		  ขยายภาพ

 	 Zoom out		  ย่อภาพ

 	 Refit			   แสดงผลให้เหมาะสมกับหน้าต่าง 	

 	 Reorient		  กำหนดมุมมองเอง

 	 Named View List	 แสดงรายการมุมมองภาพ

 	 Layers			  เปิด-ปิด เลเยอร์

 	 View Manager	 การจัดการกับคำสั่งต่างๆที่ใช้จัดการแสดงผลของโปรแกรม
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	 Wireframe		  แสดงผลแบบโครงสร้าง

 	 Hidden line		  แสดงผลแบบโครงสร้างรวมทั้งเส้นที่ถูกบัง

 	 No hidden		  แสดงผลแบบโครงสร้างแบบไม่แสดงเส้นที่ถูกบัง

 	 Shading		  แสดงผลแบบเป็นเฉดสีของโมเดล

Toolbar ของเมนู Model Display

	 What’s This?		 ตัวช่วยในการแสดงคำอธิบายสิ่งต่างๆที่ลากเมาส์คลิกลงไป

Toolbar ของเมนู Help 

	 ในส่วนนี้โปรแกรม Pro/ENGINEER  ได้ดึงเอา Feature ที่ใช้อยู่ประจำ มาจัดวางเป็นไอคอน

เพื่อการให้ผู้ใช้งาน เรียกใช้งานได้อย่างสะดวก และรวดเร็ว  ใน Feature Toolbar ที่ใช้เป็นประจำ 

แบ่งออกเป็น 4 กลุ่ม คือ Datum Feature Tools, Direct Feature Tools, Basic Feature Tools 

 และ Editting 

Feature Toolbar

	 Plane Display	 เปิด-ปิด การแสดงผลของ Datum Plane

 	 Axis Display		  เปิด-ปิด การแสดงผลของ Datum Axis

 	 Point Display		 เปิด-ปิด การแสดงผลของ Datum Point

 	 Csys Display		  เปิด-ปิด การแสดงผลของ Datum Coordinate systems

 	 Annotation Element Display	 เปิด-ปิด การแสดงรายละเอียดที่อยู่บนภาพ 3 มิติ

Toolbar ของเมนู Datum Display
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Datum Feature Tools

	 เป็นการสร้าง Datum feature ต่างๆ เพื่อใช้ช่วยในการออกแบบหรือเรียกว่า Referrence 

geometry ประกอบด้วย

Sketch		  สร้าง Sketch Datum Curve

 Plane			  สร้าง Datum Plane

 Axis			   สร้าง Datum Axis

 Curve			  สร้าง Datum Curve

 Point			  สร้าง Datum Point

 Coordinate System	   สร้าง Datum Coordinate

 Analysis		  Datum Analysis

Direct Feature Tools

 	 เป็นการสร้าง Feature ประเภท Pick & Place หรือ Direct Feature กล่าวคือ Feature 

ประเภทนี้ สามารถสร้างได้โดยตรงกับ Geometry ของโมเดลที่มีอยู่นั้นได้โดยตรง

 Hole		  สร้าง Feature Hole (เจาะรู)

 Shell		 สร้าง Feature Shell (คว้านเนื้อชิ้นงาน)

 Rib		  สร้าง Feature Rib (เสริมครีบ)

 Draft		  สร้าง Feature Draft (ผิวเอียง)

 Round	 สร้าง Feature Fillet หรือ Round (ขอบผิวโค้ง)

 Edge Chamfer สร้าง Feature Chamfer (มุมตัดเหลี่ยม)
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Basic Feature

       Feature ได้แก่ Extrude, Revolve, Variable section sweep เป็น Feature หลัก 

ในการสร้างโมเดล  	

Extrude 	 สร้าง Feature Extrude (ยืดผิว)

 Revolve	 สร้าง Feature Revolve (สร้างผิวเป็นวงรอบจุดศูนย์กลาง)

 Variable section sweep	 สร้าง Feature โดยการสร้างผิวจาก Section ตามเส้น Path

Editing

      เป็น Feature ในการแก้ไข และเปลี่ยนแปลง Feature ที่ถูกสร้างขึ้น

Mirror		 Copy Feature แบบภาพสะท้อน

Merge		 รวมผิวของ Surface ของวัตถุเข้าด้วยกัน

Pattern	 Copy ครั้งละหลายๆ Feature จาก Feature ที่กำหนดเป็นต้นแบบ

Navigator

 	 Navigator มีองค์ประกอบสำคัญๆ ในส่วนนี้ประกอบด้วย Model Tree, Folder Brows,  

Dashboard และ Message Area

 

	 Model Tree      เป็นการแสดงรายการของ Feature ที่สร้างขึ้นในโมเดลนั้นๆ 

เรียงลำดับก่อนหลัง  ซึ่งแสดงผลอยู่ทางซ้ายมือของจอภาพ นอกจากนั้นยังแสดงรายการของเลเยอร์ด้วย

	 การสลับการแสดงผลระหว่าง Model Tree และ Layer นั้นสามารถทำได้โดยการกดปุ่ม 

เปิด-ปิดเลเยอร์          ซึ่งอยู่ในแถบเครื่องมือด้านบน 
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 	 หรือโดยการเปลี่ยนจาก Model Tree เป็นเลเยอร์โดยกดที่แถบ Show ด้านบนของ Model Tree 

หรือ เปลี่ยนจาก Layer เป็น Model Tree  ดังรูป
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 	 Folder Browser       เป็นการรวมเอา 

คำสั่ง Explorer ของ Windows มาใช้ร่วมกับโปรแกรม 

Pro/ENGINEER  เพื่อใช้ในการจัดการระบบไฟล์ต่างๆ  

ทำให้ง่ายต่อการกำหนด directory ที่ใช้งาน

สามารถเปิดไฟล์โดยใช้ Folder Browser นี้ได้เลย

 

 	 Dashboard  โปรแกรม Pro/ENGINEER มีแผงควบคุม สำหรับเลือกรูปแบบการทำงานของแต่ละ

คำสั่ง เรียกว่า Dashboard ซึ่งจะช่วยให้การใช้งานง่ายขึ้น และ รวดเร็วขึ้น 

 Dashboard โดยทั่วไปประกอบด้วย
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	 - Feature Type  จะบอกว่า Dashboard ที่กำลังใช้งานอยู่นั้นเป็น Feature ใด

 	 - Slide-Up Panel Tabs เป็นTabเพื่อใช้คลิก เลือก Option มาใช้งาน

 	 - Message Area จะแสดงข้อความตอบโต้ระหว่างโปรแกรมกับผู้ใช้ ให้รู้ว่าจะต้องทำอะไรต่อไป

 	 - Feature Controls ใช้ในการควบคุมการทำงานของ Feature ดังนี้

               •  Pause/Resume ปุ่ม Pause        จะใช้สำหรับหยุดการสร้าง Feature ไว้ชั่วคราว 

เพื่อไปทำอย่างอื่นก่อน เมื่อเสร็จแล้วการกลับไปยัง Feature ที่ทำค้างอยู่โดยการกดปุ่ม Resume  

               •  Verify หรือ Preview            เป็นการแสดงผลตัวอย่างของ Feature ก่อน

               •  OK หรือ Complete Feature        เป็นการยอมรับและเสร็จสิ้นการสร้างFeature

               •  Cancel      เป็นการยกเลิกการสร้าง Feature นั้นๆ

 Message Area  เป็นพื้นที่แสดงข้อมูล และข้อความตอบโต้ หรือคำแนะนำ 

 ใน การ ใช้งาน Pro/ENGINEER ในแต่ละ Feature ที่ใช้งานขณะนั้น 

 	 รูปแบบไอคอนใน Message Area 
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การใช้เมาส์ในโปรแกรม 

	 ในโปรแกรม Pro/ENGINEER  มีลักษณะการใช้เมาส์ร่วมกับคีย์บอร์ด  ดังนี้

 	 การใช้เมาส์  

 		  การหมุน(Spin)  โดยกดปุ่มกลางของเมาส์ค้างไว้แล้วเลื่อนเมาส์เพื่อหมุนวัตถุ หรือ Scroll  

 	 ค้างไว้เพื่อหมุนภาพ

 		  การย่อ-ขยายภาพ (Zoom) โดยกดปุ่ม Ctrl ที่แป้นคีย์บอร์ดพร้อมกับหมุนปุ่มกลาง 

 	 ของเมาส์ หรือ Scroll ที่เมาส์ไปมา

 		  การเคลื่อนภาพ (Pan)  โดยการกดปุ่ม Shift ที่แป้นคีย์บอร์ด พร้อมกับกด ปุ่มกลาง 	

	 ของเมาส์ หรือ Scroll ที่เมาส์ค้างไว้ แล้วเลื่อนเมาส์ไปมา

  	 การย่อ-ขยาย (Zoom) มี  4 วิธี ดังนี้

 		  1. หมุนปุ่ม Scroll ขึ้นลง

		  2. กดปุ่ม Ctrl ที่แป้นคีย์บอร์ด พร้อมกับหมุนปุ่ม Scroll ขึ้นลง

		  3. กดปุ่ม Ctrl + ปุ่ม Scroll พร้อมเลื่อนเม้าส์ขึ้นลง

		  4. กดปุ่ม Shift ที่แป้นคีย์บอร์ด พร้อมกับหมุนปุ่ม Scroll ขึ้นลง



บทที่3
การสร้างชิ้นงาน และการใช้เครื่องมือ 

- การกำหนด Working Directory

- การจัดการไฟล์ชิ้นงาน  

- การใช้ Features พื้นฐาน

การกำหนด Working Directory
 	 เมื่อเปิดใช้งานโปรแกรม Pro/ENGINEER สิ่งที่ควร 

ดำเนินการก่อนทุกครั้ง คือ การกำหนด Working Directory  

ซึ่งเป็น directory ที่ใช้ในการบันทึกและจัดเก็บไฟล์ต้นฉบับ

ในการทำงาน เพื่อประโยชน์ในการแก้ไขชิ้นงานในภายหลัง  

สามารถทำได้ 2 คือ

 

	  วิธีที่ 1     Set Working Directory จาก เมนู File

          วิธีที่ 2     การกำหนด Working Directory โดยเริ่ม 

จากการคลิกเมาส์ขวา  

 	 ซึ่งแต่ละวิธี มีรายละเอียดขั้นตอน ดังนี้

Chapter
ในการจัดการชิ้นงาน
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1.  เลือกคลิกคำสั่ง File > Set Working Directory

วิธีที่ 1	Set Working Directory จาก เมนู File

2.  เลือกไดเรกทอรีที่ใช้ในการทำงาน แล้วคลิกปุ่ม OK
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1. คลิกรายการ Working Directory จากหน้าต่างด้านซ้ายมือ

วิธีที่ 2  การกำหนด Working Directory โดยการคลิกเมาส์ขวา

2. คลิกเมาส์ขวาบนโฟลเดอร์ 

ต่อจากนั้นเลือกคำสั่ง Set Working Directory



29

การจัดการไฟล์ชิ้นงาน

 	 การเลือกชนิดของชิ้นงานมีขั้นตอนดังนี้

	  	 1. สร้างไฟล์ใหม่โดยเลือกคำสั่ง File > New… จากแถบเมนู File หรือที่ไอคอน NEW   

ต่อจากนั้นจะพบหน้าต่างดังนี้

		  2. พิมพ์ชื่อไฟล์ในช่อง Name  โดยมีหลักการ ดังนี้

			   2.1. ใช้พยัญชนะภาษาอังกฤษ และตัวเลขในการตั้งชื่อ

			   2.2. ไม่เว้นช่องว่าง 

 			   2.3. ไม่ใช้เครื่องหมายพิเศษใดๆ เช่น  / . @ # $ & 

		  3. คลิกปุ่ม OK

การเลือกชนิดของชิ้นงาน
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	 การทำงานด้วยโปรแกรม Pro/ENGINEER งานทั้งหมดที่ทำจะถูกเก็บไว้บนหน่วยความจำของ 

เครื่อง (RAM) เมื่อปิดโปรแกรมจะมีการเตือนว่าไฟล์ที่ยังไม่ได้บันทึกจะถูกลบ ดังนั้นจึงต้องมีการบันทึก 

ไฟล์งานทุกครั้งก่อนปิดโปรแกรม

	 การจัดเก็บไฟล์งานที่สร้างโดยโปรแกรม Pro/ENGINEER จะถูกเก็บไว้ที่ Working Directory 

ที่กำหนดไว้ การบันทึกไฟล์งานสามารถทำได้  โดยการคลิกไอคอน       หรือ ใช้คำสั่งบนแถบเมนู   

File > Save

	 การบันทึกไฟล์งานในชื่อใหม่สามารถทำได้โดยการใช้คำสั่งบนแถบเมนู File > Save A Copy  

จากนั้นพิมพ์ชื่อไฟล์ใหม่ในช่อง New Name แล้วคลิกปุ่ม OK

การจัดเก็บและบันทึกไฟล์

	 ในกรณีที่ผู้ใช้ต้องการนำไฟล์ที่สร้างโดยโปรแกรม Pro/ENGINEER ไปใช้งานกับโปรแกรมอื่น ๆ 

สามารถดำเนินการได้  ดังนี้ 

      	 1. ที่แถบเมนู เลือกคำสั่ง File > Save a  Copy…

การบันทึกไฟล์ในรูปแบบอื่น
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 		  2. คลิกปุ่ม Drop Down List  ในหัวข้อ Type  แล้วคลิกเลือกประเภทไฟล์ที่ต้องการ 

ตัวอย่างเช่น ต้องการบันทึกไฟล์งานเป็นภาพสกุล  JPG  เพื่อใช้ในงานเอกสาร

 		  3. พิมพ์ชื่อไฟล์ในช่อง  New Name จากนั้นคลิกปุ่ม OK
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 		  4. กำหนดขนาดในช่อง Size  กำหนดความละเอียดภาพในช่อง DPI  จากนั้นคลิกปุ่ม OK

	 การพิมพ์งานไฟล์ที่เปิดทำงานอยู่ออกทางเครื่องพิมพ์ จะใช้เครื่องพิมพ์ที่มีอยู่ใน MS Printer 

Manager ขั้นตอนการสั่งพิมพ์สามารถทำได้ด้วยวิธีการดังต่อไปนี้

		  1. ที่แถบเมนูเลือกคำสั่ง File > Print   

หรือ คลิกที่ไอคอน      บนแถบเครื่องมือ

		  2. ที่หน้าต่าง Print คลิกปุ่ม OK

การพิมพ์งานออกทางเครื่องพิมพ์



33

	 3.  เลือกเครื่องพิมพ์ในช่อง Name กำหนดตัวเลือกอื่น ๆ จากนั้นคลิกปุ่ม OK

	 การทำงานด้วยโปรแกรม Pro/ENGINEER โปรแกรมจะทำงานบนหน่วยความจำของเครื่อง 

(RAM) หมายความว่าเมื่อมีการเปิดไฟล์ในแต่ละครั้ง มีการทำงานในแต่ละขั้นตอนโปรแกรม 

จะบันทึก ไว้บนหน่วยความจำ  แม้ว่าจะปิดไฟล์นั้นๆ  แต่สิ่งที่โปรแกรมได้บันทึกไว้บนหน่วยความจำ 

จะยังคงอยู่ เมื่อทำงานเป็นเวลานานๆ หรือเปิดชิ้นงานจำนวนมาก  จะมีการใช้หน่วยความจำที่มากขึ้น 

ทำให้โปรแกรมทำงานช้าลง หรือหยุดการทำงาน  ดังนั้น การลบไฟล์ที่ไม่ต้องการบนหน่วยความจำ   

จะทำให้การทำงานมีประสิทธิภาพดีขึ้น โดยมีขั้นตอนดังนี้

การจัดการหน่วยความจำของคอมพิวเตอร์ในการทำงาน
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 	 1. ที่แถบเมนูเลือกคำสั่ง  File > Erase > Not Display… 

 	 2. การลบหน่วยความจำของไฟล์ที่เปิดใช้งานอยู่ทำได้โดยเลือกคำสั่ง  File > Erase > Current  

บนแถบเมนู  เมื่อปรากฎหน้าต่าง Erase ให้คลิกปุ่ม OK

การลบไฟล์ในหน่วยความจำโดยวิธีการนี้จะลบได้ทีละไฟล์ซึ่งเป็นไฟล์ที่กำลังเปิดใช้งานอยู่ หลังจากคลิก 

ลบไฟล์ในหน่วยความจำจะมีหน้าต่างโต้ตอบดังภาพ
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	 โดยปกติโปรแกรม Pro/ENGINEER จะเปิดไฟล์ที่อยู่ในไดเรกทอรีที่กำหนดให้เป็น  

Working Directory แต่อย่างไรก็ตามผู้ใช้งานสามารถเลือกเปิดไฟล์ที่อยู่ในโฟลเดอร์อื่นๆ ได้เช่นกัน 

การเปิดไฟล์สามารถทำได้ดังนี้ 

 		  1. คลิกเลือกคำสั่ง File > Open  หรือคลิกไอคอน        จะพบหน้าต่าง ดังภาพ 

การเปิดไฟล์

 2. คลิกเลือกไฟล์ที่ต้องการ 

หากต้องการให้โปรแกรมแสดง

ภาพชิ้นงานให้คลิกที่ Preview 

โปรแกรมจะแสดงภาพชิ้นงาน

ดังภาพ  เมื่อเลือกไฟล์ที่ต้องการ

แล้ว คลิก Open
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การใช้งาน Feature พื้นฐาน
 	 การขึ้นรูปชิ้นงานในโปรแกรม Pro/ENGINEER  สามารถใช้ Feature พื้นฐาน 

ได้  2 ลักษณะ คือ Extrude feature และ Revolve feature  ซึ่งรายละเอียดของการใช้งานมี ดังนี้ 

1. การขึ้นรูปชิ้นงานโดยใช้  Extrude feature

 	 Extrude feature  เป็นเครื่องมือที่ใช้สำหรับขึ้นรูปชิ้นงานสามมิติ  โดยจะยืดขยายชิ้นงานหรือตั

ดชิ้นงานทิ้ง  ในแนวตั้งฉากกับภาพที่ Sketch ขึ้น  มีรูปแบบการใช้งาน 2 รูปแบบ คือ Extrude solid 

และ Extrude surface  สามารถกำหนดค่าเพิ่มเติม เพื่อขึ้นรูปชิ้นงานได้หลากหลายรูปแบบ  

ดังรูป 

                การขึ้นรูปชิ้นงานแบบเพิ่มเนื้อชิ้นงาน (Extrude protrusion)

การขึ้นรูปชิ้นงานแบบตัดเนื้อชิ้นงานทิ้ง 

(Extrude cut)
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การขึ้นรูปชิ้นงานแบบสร้างพื้นผิว  

( Extrude surface)

	 การขึ้นรูปชิ้นงานโดยใช้  Extrude feature  จะต้องทำการ Sketch รูป บนระนาบ (Datum 

plane) ที่ต้องการ  ให้แล้วเสร็จเสียก่อน  แล้วให้ปรับการตั้งค่าของ Extrude feature  เพื่อให้ได้ชิ้นงาน 

ตามที่ต้องการ  โดยมีขั้นตอนโดยสรุป ดังนี้

 	 1. ที่เมนู Insert ให้คลิกที่  Extrude…  หรือ คลิกที่ไอคอน        บนแถบเครื่องมือ

 	 2. กำหนดตำแหน่งที่ต้องการ Sketch โดยคลิกที่ Placement ตามด้วยคลิกที่ปุ่ม Define...  
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3. เลือกระนาบที่ต้องการจะทำการ Sketch รูป  โดยคลิกที่เส้นระนาบหรือ   ชื่อระนาบ (Datum plane) 

ในที่นี้เลือกที่ TOP plane

 4. เมื่อปรากฏหน้าต่างแสดงผล Sketch  

คลิกที่ปุ่ม            เพื่อทำการวาดรูป 

ที่จะใช้เป็นรูปต้นแบบ Extrude
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5. ใช้เครื่องมือวาดรูปให้เสร็จสมบูรณ์ แล้วคลิกที่ปุ่ม Done        เพื่อยืนยัน

6. กำหนดรูปแบบ/ค่าที่จะทำการ Extrude แล้วคลิกปุ่ม Applies         เพื่อยืนยันการ Extrude
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ความหมายของไอคอน เพื่อกำหนดรูปแบบ/ค่าที่จะทำการ Extrude

สร้าง Extrude feature แบบ solid

สร้าง Extrude feature แบบ surface

รูปแบบการกำหนดระยะของ Extrude

กำหนดความยาวที่ต้องการ Extrude

กำหนดทิศทางการ Extrude

กำหนดให้ Extrude ชิ้นงาน โดยตัดชิ้นงานทิ้ง (remove material)

เลือก Extrude แบบ solid thin 

แสดงภาพตัวอย่างที่ได้จากการ Extrude

ยืนยันการ Extrude

ยกเลิกการ Extrude

 	 เมื่อสิ้นสุดการ Extrude จะได้ชิ้นงาน ดังรูป

ภาพแสดงชิ้นงานจากการใช้ Extrude feature (เมื่อแสดงภาพแบบ ISOMETRIC) 

คำแนะนำ

การเลือกมุมมองแสดงภาพแบบต่างๆ

ทำได้โดยคลิกที่ไอคอน Named View List    

ที่แถบเมนู แล้วเลือกแบบที่ต้องการแสดง 



41

แบบฝึกการขึ้นรูปชิ้นงานโดยใช้ Extrude feature

 	 คำสั่ง  ให้ฝึกออกแบบขึ้นรูปชิ้นงานโดยใช้ Extrude feature ตามภาพตัวอย่างที่กำหนดให้                      

พร้อมอธิบายขั้นตอนการปฏิบัติงาน

 	 ชิ้นงานตัวอย่าง                                       ขั้นตอนการปฏิบัติ

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................
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2. การขึ้นรูปชิ้นงานโดยใช้  Revolve feature

 	 Revolve feature  เป็นเครื่องมือที่ใช้สำหรับขึ้นรูปชิ้นงานสามมิติ โดยการหมุนรอบแกนที่กำหนด      

ในแนวตั้งฉากกับภาพที่ Sketch ขึ้น  มีรูปแบบการใช้งาน 2 รูปแบบ คือ revolve solid และ revolve 

surface  สามารถกำหนดค่าเพิ่มเติม เพื่อปรับแต่งชิ้นงานได้หลากหลายรูปแบบ  ดังรูป 

              	 การขึ้นรูปชิ้นงานแบบเพิ่มเนื้อชิ้นงาน (revolve protrusion)

    		  การปรับแต่งชิ้นงานแบบตัดเนื้อชิ้นงานทิ้ง (revolve cut)

	 การขึ้นรูปหรือปรับแต่งชิ้นงานโดยใช้ Revolve feature  จะต้องทำการ sketch รูป บนระนาบ 

(datum plane) และกำหนดแกนสำหรับใช้หมุน  แล้วให้ปรับการตั้งค่าของ revolve feature   

เพื่อให้ได้ชิ้นงานตามที่ต้องการ  โดยมีขั้นตอน ดังนี้
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1. สร้างไฟล์ใหม่โดยเลือกคำสั่ง File > New 

2. ที่หน้าต่าง New  

 	 • หัวข้อ Type เลือกประเภทเป็น Part  

	 • หัวข้อ Sub-type เลือกประเภทเป็นSolid

	 • ที่ช่อง Name ให้พิมพ์ชื่อไฟล์

	 • คลิกปุ่ม OK

3. ที่แถบเมนูคลิกเลือกคำสั่ง  

Insert  >  Revolve  หรือคลิกที่ 

ไอคอน          บนแถบเครื่องมือ

 

4. กำหนดตำแหน่งที่ต้องการ 

sketch รูป โดยคลิกที่         

ตามด้วยคลิกที่ปุ่ม 

5. เลือกระนาบที่ต้องการจะทำการ 

Sketch รูป  โดยคลิกที่เส้นระนาบ 

หรือชื่อระนาบ (datum plane)
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 	 หลังจากคลิกที่เส้นระนาบ (ในที่นี้เลือกที่ 

FRONT) จะปรากฏหน้าต่างแสดงผล sketch 

ให้คลิกที่ปุ่ม              เพื่อทำการวาดรูปที่จะใช ้

เป็นรูปต้นแบบ revolve

6. กำหนดแกนที่จะใช้หมุน โดยคลิกเลือกเครื่องมือ 

Centerline          ที่แถบเครื่องมือ 

 

�́Ê��°��̧É�1 �́Ê��°��̧É 2 �́Ê��°��̧É�3   ขั้นตอนที่ 1                ขั้นตอนที่ 2                ขั้นตอนที่ 3
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แล้วคลิกเมาส์ ที่จุด X  และ จุด X  เพื่อสร้างแกนสำหรับหมุน  จากนั้นคลิกเมาส์กลาง 1 ครั้ง 

เพื่อสิ้นสุดการสร้างแกนหมุน  

X1 

X2 

7. ใช้เครื่องมือ Center and Point        วาดรูปวงกลม แล้วคลิกที่ปุ่ม Done           เพื่อยืนยัน

1 2
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8. กำหนดขนาดมุมที่จะหมุน  แล้วคลิกปุ่ม Applies       เพื่อสิ้นสุดการ revolve  จะได้ชิ้นงานดังรูป

      ภาพแสดงการสร้างชิ้นงาน เมื่อกำหนดค่ามุม 90 องศา , 270 องศา และ 360 องศา

ความหมายของไอคอนการกำหนดรูปแบบ/ค่าที่จะทำการ revolve

 

สร้าง Extrude feature แบบ solid

สร้าง Extrude feature แบบ surface

รูปแบบการกำหนดระยะของ Extrude

กำหนดความยาวที่ต้องการ Extrude

กำหนดทิศทางการ Extrude

กำหนดให้ Extrude ชิ้นงาน โดยตัดชิ้นงานทิ้ง (remove material)

เลือก Extrude แบบ solid thin 

แสดงภาพตัวอย่างที่ได้จากการ Extrude

ยืนยันการ Extrude

ยกเลิกการ Extrude
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แบบฝึกการขึ้นรูปชิ้นงานโดยใช้ Revolve feature

 	 คำสั่ง  ให้ฝึกออกแบบขึ้นรูปชิ้นงานโดยใช้ revolve feature ตามภาพตัวอย่างที่กำหนดให้  

พร้อมอธิบายขั้นตอนการปฏิบัติงาน

 	 ชิ้นงานตัวอย่าง                                       ขั้นตอนการปฏิบัติ

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................

..........................................................................................................



บทที่4
การออกแบบและสร้างขวดน้ำดื่ม

การสร้างขวดน้ำดื่ม (Sport Drink Bottle) 

 	 การออกแบบและสร้างขวดน้ำดื่ม เป็นกระบวนการ 

ฝึกการใช้งานเครื่องมือต่าง ๆ ของโปรแกรม Pro/ENGINEER 

ในการออกแบบและผลิต ที่คู่มือต้นฉบับของการใช้โปรแกรม 

นำมาเป็นแบบฝึกในการใช้งานโปรแกรม  ซึ่งหากสามารถ 

สร้างขวดน้ำดื่มได้สำเร็จ  ก็จะเกิดทักษะการใช้ชุดเครื่องมือ 

ต่าง ๆ ของโปรแกรมในการออกแบบและสร้างผลิตภัณฑ์อื่น ๆ 

ในลักษณะที่แตกต่างออกไปได้

Chapter

- การสร้างตัวขวด

- การสร้างมือจับขวด

- การสร้างคอขวด 

- การลบเหลี่ยมมุมของขวด 

- การเจาะขวด

- การสร้างขอบนูนบนปากขวด 

- การสร้างฝาขวด  

- การสร้างที่ล็อคปากขวด 

- การสร้างที่จับรอบปากขวด

- การประกอบชิ้นงาน
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การสร้างตัวขวด
 	 1. สร้าง Folder  ในที่นี้กำหนดชื่อ bottle อยู่ใน My Documents  

 	 2. เปิดโปรแกรม Pro/ENGINEER   แล้วเลือกโฟลเดอร์ bottle จากนั้นคลิกเมาส์ขวาเลือกคำสั่ง  

Set Working Directory   เพื่อกำหนด Folder สำหรับการทำงาน และจัดเก็บชิ้นงาน
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 	 3. สร้างไฟล์ใหม่ที่เมนูบาร์โดยคลิกคำสั่ง File > New  ที่เมนูบาร์ จะปรากฏหน้าต่าง New 

ที่หัวข้อ Type  ให้เลือก Part  และที่หัวข้อ Sub-type ให้เลือก Solid ในช่อง Name ให้พิมพ์ชื่อไฟล์ 

“bottle” แล้วคลิก

 	 4. เมื่อปรากฏบริเวณพื้นที่ทำงาน (Datum Planes)  ประกอบด้วย FRONT , TOP , RIGHT , 

DEFAULT_CSYS 

 	     

สำหรับการสร้างชิ้นงาน  

DEFAULT_CSYS 

ไม่จำเป็นต้องเปิดใช้  

ให้ทำการปิด Coordinate 

System on/off 
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 	 5. คลิกที่ ไอคอน   Extrude Feature          หรือ Insert Extrude  ที่ Menu 

             จะปรากฏแถบ Dashboard  สำหรับกำหนดค่า ต่างๆ ของการ Extrude

   ให้คลิกที่  Placement   แล้วคลิกที่ปุ่ม Define
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 	 6. ในหน้าต่าง Sketch ให้เลื่อนเมาส์ไปที่เส้น Top Datum Plane  เพื่อเลือก Plane  

จากนั้นคลิกที่ปุ่ม Sketch 

 	 7. เริ่มสร้างงานโดยคลิกปุ่ม Center and point        ที่ทูลบาร์ขวามือ 
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 	 8. คลิกเมาส์ที่จุดตัดของเส้น reference (X1) เพื่อกำหนดจุดศูนย์กลางของวงกลม  

เลื่อนเมาส์ออกจากจุดศูนย์กลาง จะปรากฏรูปวงกลม เมื่อได้ขนาดตามต้องการแล้วคลิกเมาส์(X2) 

คลิกปุ่มกลางของเมาส์ เพื่อเป็นการสิ้นสุดการสร้างวงกลม

 	 9. กำหนดเส้นผ่านศูนย์กลางของวงกลม โดยดับเบิลคลิกที่ ตัวเลข เปลี่ยนค่าเป็น 65 mm แล้ว 

กดปุ่ม Enter ที่แป้นพิมพ์
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 	 10. สร้างวงกลมอีกหนึ่งรูป โดยให้จุดศูนย์กลางอยู่ในแนวระดับเดียวกัน และมีเส้นผ่านศูนย์กลาง 

เท่ากับ 25 mm ด้วยวิธีการเดียวกับวงกลมรูปแรก

 	 11. กำหนดขนาด ระยะห่างระหว่างจุดศูนย์กลางของวงกลมทั้งสอง โดยดับเบิลคลิกที่ ตัวเลข 

เปลี่ยนค่าเป็น 65 mm แล้ว กดปุ่ม Enter ที่แป้นพิมพ์
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 	 12. สร้างเส้นสัมผัสเชื่อมต่อจากจุด X1 กับ X2   และ X3 กับ X4   โดยใช้เครื่องมือ  

LineTangent        ที่ทูลบาร์ขวามือ 
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 	 13. ใช้เครื่องมือ Delete Segment          ลบเส้นที่ไม่ต้องการออก โดยคลิกที่เส้น จนได้ผลลัพธ์ 

ดังรูป 

 	 14. คลิกที่ปุ่ม Done        เพื่อยืนยัน จะได้ผลดังรูป



 	 15. ปรับเปลี่ยนมุมมองเพื่อให้เห็นลักษณะชิ้นงานแบบ 3 มิติ โดยคลิกปุ่ม Named View List                    

              แล้วเลือกแบบ ISOMETRIC 
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 	 16. ปรับความสูงของขวด เท่ากับ 160 mm ตามรูป 

หรืออาจปรับความสูงได้โดยดับเบิลคลิกที่ตัวเลขสเกล  แล้วกำหนดตัวเลขตามต้องการ

จากนั้นให้คลิกปุ่ม Applies   

ที่มุมบนขวา  เพื่อยอมรับการเปลี่ยนแปลง
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 	 17. ให้บันทึกงานไว้โดยคลิกที่ปุ่ม Save          ตรวจสอบแหล่งเก็บและชื่อไฟล์งาน 

ให้ถูกต้องแล้วคลิก  
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การสร้างมือจับขวด

 	 1. ที่แถบทูลบาร์ขวามือ ใช้เมาส์คลิกเลือกที่ปุ่ม  Revolve  

 	 2. บนแถบ Dashboard  ให้คลิกที่ Placement 

แล้วคลิกปุ่ม   Define
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 	 3. เมื่อปรากฏหน้าต่าง Sketch ให้คลิกที่ Plane FRONT  คลิกปุ่ม Sketch  ในหน้าต่าง Sketch  

 	 4. คลิกปุ่ม Center and Point        ที่แถบทูลบาร์ขวามือ  แล้วสร้างวงกลม 2 วง ให้มีขนาดเท่ากัน  

และมีจุดศูนย์กลางอยู่ในแนวเดียวกัน ดังภาพ

 	 ข้อสังเกต    ในขณะที่เลื่อนเมาส ์

เพื่อหาตำแหน่งที่จะกำหนดเป็นจุดศูนย์กลาง

ของวงกลมวงที่สอง  หากตำแหน่งของจุดศูนย์ 

กลางอยู่ในแนวเดียวกันจะปรากฏ – (สีแดง)  

และขณะทำการปรับขนาดของวงกลม   

หากวงกลมทั้งสองมีขนาดรัศมีเท่ากันจะปรากฏ 

ตัวอักษร R   ที่จุดศูนย์กลางของวงกลมทั้งสอง1
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 	 5. สร้างเส้นสัมผัสระหว่างวงกลมทั้งสอง โดยใช้เครื่องมือ Line Tangent    

จะได้เส้นสัมผัสดังรูป

 	 6. ลบที่เส้นรอบวงด้านในของวงกลมทั้งสอง  ด้วยเครื่องมือ Delete Segment 
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  	 7. สร้างแกนหมุน ด้านซ้ายมือ ของขวด 

โดยใช้เครื่องมือ Centerine        

ด้วยการ  คลิกเมาส์ที่ตำแหน่ง X1 แล้วเลื่อน 

เมาส์มาคลิกที่ตำแหน่ง X2  ดังภาพ 

A  เป็นระยะขอบข้างถึงขอบมือจับเท่ากับ  25 mm.

B  เป็นระยะความกว้างของช่องมือจับเท่ากับ  30 mm.

C  เป็นระยะขอบข้างถึงเส้นแกนหมุนเท่ากับ  30 mm.

D  เป็นระยะขอบบนถึงช่องมือจับด้านบนเท่ากับ  20 mm.

E  เป็นระยะขอบล่างถึงช่องมือจับด้านล่างเท่ากับ  20 mm.

  8. กำหนดสเกล (Dimension) โดยใช้เครื่องมือ 

normal           โดยระยะห่างของสเกลกำหนดให้  

ดังนี้
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	 การกำหนดระยะขอบข้างถึงมือจับ (A) ทำโดยใช้เครื่องมือ Normal           แล้วนำเมาส์ คลิก 

ที่เส้นขอบของขวด (X1) ต่อจากนั้นนำเมาส์คลิกลงบนเส้นขอบมือจับ (X2) แล้วคลิกปุ่มกลางบนเมาส์ใน 

ตำแหน่งที่ต้องการแสดงระยะ (X3) กำหนดระยะโดยการดับเบิลคลิกที่ตัวเลขบอกระยะแล้วกำหนด 

ขนาดใหม่โดยการพิมพ์ตัวเลข 25 แล้วกดปุ่ม Enter ที่แป้นพิมพ์

ในส่วนของจุด B C D และ E  

มีขั้นตอนในการกำหนดค่าระยะห่าง 

ในลักษณะเดียวกันกับจุด A 

 	 9. เมื่อกำหนดค่าระยะห่างครบทุกจุดแล้ว  แล้วคลิกที่ปุ่ม Done     

 	 10. ปรับเปลี่ยนมุมมองเพื่อให้เห็นลักษณะชิ้นงานแบบ 3 มิติ โดยคลิกปุ่ม Named View List     

          แล้วเลือกแบบ ISOMETRIC 
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 	 11. ทำการเฉือนเนื้อชิ้นงานออก โดยคลิกที่ปุ่ม Remove Material         ที่แถบ Dashboard 

จะปรากฏ Plane รูปสเก็ตเป็นเส้นสีเหลืองเจาะทะลุขวดน้ำ ดังภาพ

  	 12. เมื่อคลิกปุ่ม Applies           เพื่อยอมรับการเปลี่ยนแปลง  จะได้รูปชิ้นงานของขวดน้ำ

ที่มีช่องมือจับตามต้องการ ดังภาพ

 	 13. บันทึกงานไว้โดยคลิกที่ปุ่ม Save        จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บและ

ชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  
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การสร้างคอขวด
 	 1. คลิกเลือกที่ปุ่ม   Named View List               ที่แถบเครื่องมือแล้วเลือก ISOMETRIC         

เพื่อปรับมุมมองให้แสดงผลในลักษณะ ISOMETRIC

 	 2.  คลิกที่ Extrude feature            เพื่อเพิ่มเนื้อชิ้นงานในส่วนของคอขวด

จะปรากฏแถบ Dashboard  สำหรับกำหนดค่า ต่างๆ ของการ Extrude

 คลิกที่  Placement   แล้วคลิกที่ปุ่ม Define
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 	 3. คลิกที่ด้านบนของขวด แล้วคลิกปุ่ม Sketch เพื่อเลือกพื้นผิวที่จะทำการสร้างคอขวด

 	 4.  คลิกปุ่ม Create circle          ที่แถบทูลบาร์ขวามือ  แล้วสร้างวงกลม 1 วง โดยคลิกจุดเริ่มต้น

ที่จุดตัดกันของเส้นอ้างอิงสีน้ำตาลทั้งสองเส้น ซึ่งตามรูปจะกำหนดเป็นจุด X1แล้วเลื่อนเมาส์ออกจากจุด X1 

ไปยังด้านขอบคลิกที่จุด X2 แล้วเลื่อนเมาส์ออกมา  จากนั้นคลิกเมาส์ปุ่มกลางเพื่อสิ้นสุดการทำงาน
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ปรับขนาดของวงกลมโดยเลือกเครื่องมือ           ดับเบิลคลิกที่ตัวเลขบอกขนาดของเส้นผ่านศูนย์กลาง

แล้วเปลี่ยนขนาดโดยพิมพ์ตัวเลข 50 แล้วกดปุ่ม  Enter บนแป้นพิมพ์ เพื่อให้ยอมรับการเปลี่ยนแปลง 

จากนั้นเลือกที่ปุ่ม Done   

 	 5.  คลิกเลือกปุ่ม   Named View List           ที่แถบเครื่องมือแล้วเลือก ISOMETRIC  

เพื่อปรับมุมมองให้แสดงผลในลักษณะ ISOMETRIC  
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 	 6.  แก้ไขค่าความสูงของคอขวด ที่แถบ Dashboard  เป็น 15 mm  จากนั้นให้คลิกปุ่ม Applies      

        ที่มุมบนขวา  เพื่อยอมรับการเปลี่ยนแปลง

จะได้รูปของขวดน้ำที่มีคอขวดตามต้องการ ดังรูป

 	 7.  บันทึกงานไว้โดยคลิกที่ปุ่ม Save             จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บและ

ชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  



70

การลบเหลี่ยมมุมของขวด

 	 การลบเหลี่ยมมุมของขวด  โดยใช้เครื่องมือ Round Feature 

Extrude  เพื่อให้ขวดมีลักษณะที่โค้งมนนุ่มนวลขึ้น  มีวิธีการใช้งาน ดังนี้

 	 1. คลิกเลือกปุ่ม  Named View List             ที่แถบเครื่องมือ 

ทูลบาร์ เลือก ISOMETRIC   เพื่อปรับมุมมองให้แสดงผลในลักษณะ  

ISOMETRIC  และหมุนวัตถุให้เห็นขอบมือจับทั้งสองด้านเพื่อสะดวก 

ในการเลือกขอบชิ้นงานที่ต้องปรับลบเหลี่ยม   
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 	 2.  ที่แถบทูลบาร์ขวามือ คลิกปุ่ม Round Feature Extrude  

 	 3. คลิก เส้นขอบของมือจับทั้งหมด  

โดยคลิกเส้นแรกแล้วกดปุ่ม Ctrl ค้างไว้แล้ว 

คลิกเลือก เส้นขอบที่เหลือทั้งสองด้าน เส้นขอบ 

ที่ถูกคลิกเลือกจะเปลี่ยนเป็นเส้นสีแดง ตามรูป
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 	 4. คลิกป้อนค่ารัศมีใน Dashboard บนแถบเครื่องมือด้านบน โดยค่าของรัศมีที่กำหนดไว้   คือ

จากนั้นให้คลิกปุ่ม Applies           ที่มุมบนขวา  เพื่อยอมรับการเปลี่ยนแปลง  จะได้รูปขวดน้ำที่ม ี

ช่องมือจับ  ปรับลบเหลี่ยมเป็นผิวโค้งตามต้องการ

 	 5. ปรับลบเหลี่ยมของขอบด้านบน ขอบด้านล่าง และรอยเชื่อมระหว่างปากขวดกับตัวขวด      

   ด้วยวิธีการเดียวกัน    
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 	 6. คลิกปุ่ม Applies           เพื่อยอมรับการเปลี่ยนแปลง 

 กำหนดรัศมีเป็น 3.00 mm

 	 7.  บันทึกงานไว้โดยคลิกที่ปุ่ม Save             จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บ 

และชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  

การเจาะขวด
	 เครื่องมือ Shell   เป็นเครื่องมือที่ใช้สำหรับเจาะคว้าน 

ชิ้นงาน  ในการเจาะคว้านขวดมีวิธีการดังนี้

	  	 1. ที่แถบทูลบาร์ขวามือ คลิกปุ่ม  Shell           
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 	 2. คลิกเมาส์บริเวณปากขวดที่ต้องการคว้านเนื้อชิ้นงาน   

 	  3. ปรับขนาดความหนาของขวดที่ แถบ Dashboard   

เป็น 1.5 mm. จากนั้นยืนยันการสร้างคลิกปุ่ม Applies      

 จะได้ชิ้นงานดังรูป 

 	 4.  บันทึกงานไว้โดยคลิกที่ปุ่ม Save             จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บ 

และชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  
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การสร้างขอบนูนบนปากขวด

	 การสร้างขอบนูนบนปากขวด  เพื่อให้เป็นจุดที่ใช้สำหรับล็อคฝากขวด มีขั้นตอนดังนี้

		  1. ที่แถบทูลบาร์ขวามือ คลิกปุ่ม Revolve         
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	 2. จะได้แถบ Dashboard

ให้คลิก Placement แล้วคลิกปุ่ม Define

เมื่อปรากฏหน้าต่าง Sketch ให้คลิกที่ Plane “FRONT”  จากนั้นคลิกปุ่ม Sketch  ในหน้าต่าง 

Sketch  

 	 3.  ที่เมนูบาร์ คลิกเลือกคำสั่ง Sketch  ->  References……
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 	 4. เมื่อปรากฏหน้าต่าง  References ให้คลิกที่ขอบบนของปากขวด ตำแหน่ง X1 และตำแหน่ง X2 

เพื่อสร้างแนวเส้นอ้างอิง จากนั้นคลิก  

       5. ขยายภาพให้ใหญ่ขึ้นแล้ว คลิกปุ่ม Center and Point          จากนั้นคลิกเมาส์ที่ตำแหน่ง 

X1 บริเวณขอบของ Bottle เลื่อนเมาส์เพื่อให้ได้ขอบของวงกลมเสมอกับปาก Bottle แล้ว 

คลิกเมาส์ที่ตำแหน่ง X2 จากนั้น ยกเลิกการใช้เครื่องมือสร้างวงกลม  โดยคลิกที่ปุ่มกลาง                  

ของเมาส์
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         6.  คลิกปุ่ม Line        แล้วสร้างเส้นตัดวงกลม  โดยคลิกที่ เส้นขอบตำแหน่ง X1 และ X2                      

แล้วคลิกปุ่มเมาส์กลางดังภาพ

     คลิกปุ่ม Delete segment          เพื่อใช้ตัดส่วนของวงกลมที่ไม่ต้องการโดยคลิกบริเวณ

     ที่ต้องการตัด X1 ดังภาพ
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        7.  กำหนด Dimension  เป็น 1.5 mm. แล้วกด Enter 

 	 8.  คลิกเครื่องมือ  Centerline             แล้วสร้างเส้น Centerline ตามภาพที่แกนตั้ง

 	 9. คลิกปุ่ม Done            

เพื่อยืนยันการสร้างชิ้นงาน 
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 	 10. จากนั้นคลิกปุ่ม Applies         เพื่อสิ้นสุดการทำงาน

 	 11.  บันทึกงานไว้โดยคลิกที่ปุ่ม Save           จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บและ

ชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  
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การสร้างฝาขวด  

	 1. สร้างไฟล์ใหม่ โดยกำหนดดังนี้

Type = Part, Name = cap  จากนั้นคลิกปุ่ม OK

	    2. คลิกปุ่ม Revolve         จากแถบ 

เครื่องมือด้านขวา   Dash Board ด้านบนของพื้นที ่

ทำงานจะเปลี่ยนแปลงไป ดังภาพ

ในการสร้างฝาในครั้งนี้ต้องการสร้างจากเส้นโดยมีการกำหนดความหนาของฝาขวดจากเส้นที่ร่างภาพ 

ให้คลิกปุ่ม Thicken Sketch เพื่อกำหนดความหนาของเส้นเป็น 2.17  แล้วกดปุ่ม Enter 

 

 		  3. ที่แถบ Dashboard  ให้คลิก                  แล้วคลิกปุ่ม    
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	 4. คลิก Front บนหน้าต่างการทำงาน แล้วคลิกปุ่ม Sketch บนหน้าต่างโต้ตอบ

	 5. คลิก Centerline             จากแถบเครื่องมือด้านขวา  (เครื่องมือ Centerline ปกต ิ

จะไม่แสดงให้เห็น  จะเลือกได้โดยคลิกที่ลูกศรด้านข้างของเครื่องมือ Line) 
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	 หลังจากเลือกเครื่องมือ Centerline แล้วให้นำเมาส์มาคลิกที่แกนอ้างอิงบนหน้าต่างวาดภาพ 

ที่ตำแหน่ง X1 ต่อจากนั้นเลื่อนเมาส์ลงมาตามแนวดิ่งแล้วคลิกอีกครั้งที่ตำแหน่ง X2 เป็นการกำหนด 

แกนสำหรับใช้เป็นแกนหมุน  

X1 

X2 

	 6. วาดภาพโครงสร้างของฝาขวด โดยเลือกเครื่องมือ Line            จากนั้นวาดภาพลงบนพื้นที่

วาดภาพโดยเริ่มจากเส้นอ้างอิงในแนวนอน โดยคลิกเมาส์ตามลำดับ X1, X2, X3, X4 ดังภาพ

	 หลังจากวาดภาพแล้วยกเลิกการใช้เครื่องมือ Line โดยการกดปุ่ม Scroll บนเมาส์จะมีการแสดง

ขนาดความยาวของเส้นและอื่นๆ ที่เกี่ยวข้องดังภาพ 

 

X1 

X2 

X3 

X4 
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 	 7.  กำหนดขนาดเส้นผ่าศูนย์กลางและความสูงของจุกฝาขวดโดยเลือกเครื่องมือ  

Normal             บนแถบเครื่องมือด้านขวา ต่อจากนั้นคลิกบนเส้นแกนกลางสำหรับการหมุน (X1) 

แล้วเลื่อนเมาส์มาคลิกที่เส้น X2 ต่อจากนั้นให้เลื่อนเมาส์กลับมาคลิกที่เส้นแกนกลางสำหรับการ 

หมุน (X1) อีกครั้ง เลื่อนเมาส์มายังตำแหน่งที่ต้องการแสดงตัวเลขบอกขนาดเส้นผ่าศูนย์กลาง (X3) 

แล้วกดปุ่ม Scroll บนเมาส์  

X1 X2 
X3 

	 หลังจากการทำงานตามขั้นตอนดังกล่าวข้างต้นโปรแกรมจะแสดงขนาดของเส้นผ่าศูนย์กลางของ

จุกฝาขวด ดังภาพ
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10 

 

	 ดับเบิลคลิกที่ตัวเลขบอกขนาดเส้นผ่าศูนย์กลางของจุกฝาขวด แล้วเปลี่ยนขนาดด้วยการพิมพ์ 

เลข 10 แล้วกดปุ่ม Enter

	 หลังจากกำหนดขนาดเส้นผ่าศูนย์กลางของจุกฝาขวดแล้ว ให้ทำการกำหนดความสูงของ 

จุกฝาขวด โดยการดับเบิลคลิกที่ตัวเลขบอกขนาดความยาวของเส้นบอกความสูงของจุกฝาขวด 

เปลี่ยนแปลงขนาดใหม่โดยพิมพ์ตัวเลข 15 แล้วกดปุ่ม Enter
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 	 8. กำหนดขนาดเส้นผ่าศูนย์กลางของฝาขวด โดยเลือกเครื่องมือ Normal    

บนแถบเครื่องมือด้านขวา ต่อจากนั้นคลิกบนเส้นแกนกลางสำหรับการหมุน (X1)  แล้วเลื่อนเมาส์ 

มาคลิกที่เส้น X2 ต่อจากนั้นให้เลื่อนเมาส์กลับมาคลิกที่เส้นแกนกลางสำหรับการหมุน (X1) อีกครั้ง 

เลื่อนเมาส์มายังตำแหน่งที่ต้องการแสดงตัวเลขบอกขนาดเส้นผ่าศูนย์กลาง (X3) แล้วกดปุ่ม Scroll 

บนเมาส์

 	 หลังจากทำตามขั้นตอนดังกล่าวข้างต้น  โปรแกรมจะแสดงขนาดเส้นผ่าศูนย์กลางของฝาขวด 

ดับเบิลคลิกที่ตัวเลขแสดงขนาดเส้นผ่านศูนย์กลางของฝาขวด แล้วพิมพ์ตัวเลข 53  แล้วกด Enter
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	 ปรับเปลี่ยนขนาดความสูงของฝาขวดโดยดับเบิลคลิกบนตัวเลขแสดงความสูงของฝาขวดแล้วพิมพ ์

ตัวเลข 10 แล้วคลิกปุ่ม Enter จะได้ผลลัพธ์ ดังรูป

	 9. กำหนดความเอียงของฝาขวด โดยเลือกเครื่องมือ Normal            บนแถบเครื่องมือด้านขวา 

ต่อจากนั้นคลิกบนเส้นเอียงของฝาขวด  (X1) แล้วเลื่อนเมาส์มาคลิกที่เส้นอ้างอิงแนวนอน (X2)   

ต่อจากนั้นเลื่อนเมาส์มายังตำแหน่งที่ต้องการแสดงตัวเลขบอกขนาดความเอียงของฝาขวดซึ่งอยู่ระหว่าง 

เส้นทั้งสอง  (X3) แล้วกดปุ่ม Scroll บนเมาส์
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	 หลังจากทำตามขั้นตอนดังกล่าวข้างต้น  โปรแกรมจะแสดงความลาดเอียงของฝาขวดเมื่อ 

เปรียบเทียบกับเส้นอ้างอิงในแนวนอน 

	 10. เปลี่ยนแปลงความลาดเอียงของฝาขวดโดยดับเบิลคลิกที่ตัวเลขบอกขนาดความเอียงพิมพ์ 

ตัวเลข 15 แล้วกดปุ่ม Enter 

	 11. คลิกปุ่ม Done           ที่ด้านล่างขวาของจอภาพ ภาพที่ได้มีลักษณะดังนี้
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 	 12. ปรับทิศทางการสร้างเนื้อชิ้นงานว่าต้องการสร้างเนื้อชิ้นงานจากเส้น  sketch 

ออกไปในทิศทางใดโดยคลิกปุ่ม Change direction           ซึ่งมีความหมาย ดังนี้

     คลิกครั้งที่ 1  เป็นการสร้างเนื้อชิ้นงานจากเส้น sketch ออกไปด้านนอก (ในที่นี้แทนด้วย A)

     คลิกครั้งที่ 2  เป็นการสร้างเนื้อชิ้นงานจากเส้น sketch เข้ามาด้านใน (ในที่นี้แทนด้วย B)

     คลิกครั้งที่ 3  เป็นเป็นการสร้างเนื้อชิ้นงานจากเส้น sketch ออกไปทั้งสองข้างเท่าๆ กัน

                      (ในที่นี้แทนด้วย C)

ในที่นี้การสร้างฝาขวดต้องเลือกการปรับทิศทางตามแบบ A จึงจะได้ฝาขวดขนาดที่พอดีกับขวดที่สร้าง 

ก่อนหน้านี้  ต่อจากนั้นคลิกปุ่ม applies         จะได้ชิ้นงานตามภาพ
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การสร้างที่ล็อคปากขวด

 	 1.  คลิก Revolve Feature         จากแถบเครื่องมือ Feature Toolbar  จะแสดงแถบ 

เครื่องมือเพื่อกำหนดการตั้งค่าที่แถบ Dashboard 

 	 2. ที่แถบ Dashboard  ให้คลิก                   แล้วคลิกปุ่ม    
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 	 3. เลือกระนาบ Front  และ คลิกที่ปุ่ม  					      

 	 4. เลือกมุมมองในการแสดงเพื่อให้เห็นเส้นโครงสร้างที่ถูกบัง โดยคลิกที่ปุ่ม 

Display Hidden Line   

 	 5. สร้างเส้นอ้างอิง โดยเลือกเมนู Sketch  เลือก References คลิกที่ตำแหน่ง 

จากนั้นกดปุ่ม close										        

 

 	 6. ใช้เครื่องมือ Center and 

Point สร้างวงกลม ดังภาพ  
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 	 7.  แบ่งครึ่งวงกลมตามแนวดิ่งโดยใช้เครื่องมือ Line  

 	 8.  ใช้เครื่องมือ delete segment             ลบเส้นวงกลมด้านซ้ายออก

 	 9.  ใช้เครื่องมือ Normal        	 กำหนดตำแหน่งดังภาพ

7.0
0 

1.5
0 

 

 	 10. สร้าง Centerline        แกนตั้ง ตรงจุด 	

X2 

 

 	 11. คลิกปุ่ม Done          เพื่อจบการ sketch

X2 
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 	 12. คลิกปุ่ม Applies          เพื่อยืนยันการสร้างชิ้นงานโดยใช้ Revolve feature

 	 13. บันทึกงาน  โดยคลิกปุ่ม Save            จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บ 

 และชื่อไฟล์งานตรวจสอบให้ถูกต้องแล้ว คลิก OK  

การสร้างที่จับรอบฝาขวด

 	 1. คลิก Extrude Feature 	        

จากแถบเครื่องมือ Feature Toolbar  

จะแสดงแถบเครื่องมือ    เพื่อกำหนด 

การตั้งค่าที่แถบ Dashboard 

  	 2.  คลิก Placement ในแถบเครื่องมือ Dashboard 

	 3.  โปรแกรมจะแสดงแถบเครื่องมือด้านด้านล่างดังภาพ 
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4.  คลิกปุ่ม 

  	 5.  ปรับมุมมองของชิ้นงานให้สะดวกต่อการเลือก Plane ในการ Sketch  ในที่นี้ต้องการ Sketch 

ที่ผิวด้านล่างของฝาขวด ให้คลิกผิวด้านล่างของฝาขวด 

6.  คลิกปุ่ม 

 	 7.  คลิกเมนู Sketch แล้วคลิก 

References 
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   8. คลิกเลือกที่บริเวณขอบฝาด้านนอกดังภาพ	

  9.  คลิกปุ่ม Close

10.  เลือกเครื่องมือ Circle          จากแถบเครื่องมือ	 

11.  สร้างรูปวงกลมโดยให้จุดศูนย์กลางของวงกลมอยู่บนจุดตัดระหว่างเส้น horizontal และ  

References ที่สร้างขึ้นใหม่  โดยคลิกเมาส์ที่ตำแหน่ง X1  ที่จุดตัด  จากนั้นให้คลิกเมาส์ที่ตำแหน่ง X2 

เพื่อกำหนดเส้นรอบวง  แล้วให้คลิกเมาส์ปุ่มกลางเพื่อจบการสร้างวงกลม
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12. กำหนด Diameter เป็น 4.00  

 	 13. เลือกเครื่องมือ Line       จากแถบเครื่องมือ เพื่อสร้างรูปครึ่งวงกลม โดยคลิกเมาส์ที ่

ตำแหน่ง X1 ที่จุดศูนย์กลางวงกลม  และ X2  แล้วให้คลิกเมาส์ปุ่มกลางเพื่อจบการทำงาน

 	 14. เลือกเครื่องมือ Dynamic Trim   	         จากแถบเครื่องมือเพื่อทำการตัดเส้นโดย 

คลิกเมาส์ตามตำแหน่ง X1  และ  X2  จากนั้นคลิกเมาส์ปุ่มกลางเพื่อจบการทำงาน ดังภาพ	
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 	 15.  คลิกปุ่ม             เพื่อจบการ Sketch  จะได้ผลลัพธ์ดังภาพ

 	 16.  กลับทิศทางของ Extrude ซึ่งทำได้ 3 วิธี คือ คลิกที่ลูกศร หรือใช้เครื่องมือ   

บนแถบเครื่องมือ Dashboard หรือคลิกที่จุดสีขาวแล้วลากขึ้นลงตามต้องการ

 	 17.  เลือกเครื่องมือ        

บนแถบเครื่องมือ Dashboard เพื่อกำหนด 

หน้าพื้นผิวของงานที่ทำการ Extrude   

ให้เท่ากันหรือเสมอกับผิวของฝาขวด
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หรือจะใช้การคลิกขวาที่จุดสีขาว แล้วเลือก To selected ก็ได้	

 	 18. คลิกที่พื้นผิวบนฝา  เพื่อกำหนดตำแหน่งงานที่  Extrude ไว้ให้มีหน้าสัมผัสที่เท่ากัน 

 	 19.  คลิกปุ่ม Applies         เพื่อเป็นการเสร็จสิ้นการทำงาน
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 	 ในการสร้างส่วนประกอบของชิ้นงานที่มีลักษณะเหมือนกัน สามารถทำได้โดยสร้างส่วนประกอบ 

ของชิ้นงานเพียงชิ้นเดียวแล้วใช้คำสั่ง Pattern  

	 ในกรณีของที่จับรอบฝาขวดซึ่งได้สร้างส่วนประกอบของที่จับรอบฝาขวดหนึ่งชิ้นดังปรากฏ 

ในขั้นตอนที่ผ่านมา ต่อจากนั้นจะใช้คำสั่ง Pattern เพื่อสร้างส่วนประกอบแบบเดียวกันรอบฝาขวด 

ดังขั้นตอนต่อไปนี้

  	 20. ใน Navigator window 

ทางซ้ายของหน้าจอ  คลิกขวา ที่ Extrude  

แล้วคลิก Pattern…
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 	 ถ้าหากไม่มีเส้นแกน (Axis)ให้เลือก  สามารถกำหนดให้แสดงเส้นแกนได้โดย คลิกไอคอน  (Axis 

Display) ที่แถบคำสั่งด้านบน  จะปรากฏเส้นแกนเพิ่มขึ้นมา ดังภาพ

  	 22. คลิกเลือกแกน (Axis) 

 	 21. คลิก dropdown menu  ของ Dimension  แล้วคลิก Axis
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 	 24. คลิก Complete Feature   

 	 25.  บันทึกงานไว้โดยคลิกที่ปุ่ม Save            จะปรากฏหน้าต่าง Save แสดงแหล่งเก็บและ

ชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  

 	 23. ที่ Dashboard  กำหนดจำนวน pattern เป็น 24 แล้วคลิก equally spaced   
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การประกอบชิ้นงาน

 	 คลิกไอคอน           New File  เพื่อสร้างไฟล์ใหม่

ใน dialog box เลือก  assembly  ตั้งชื่อ bottle_assembly  แล้วคลิกปุ่ม OK

การสร้างไฟล์ใหม่

ในกระบวนการประกอบชิ้นงาน (Assembly) ในกิจกรรมนี้ไม่ต้องการแสดงส่วนของ Plane Display, 

Csys Display และ Annotation Element Display  จึงปิดเครื่องมือต่างๆที่ไม่จำเป็นโดยคลิกปิดการแส

ดงเครื่องมือดังต่อไปนี้ คือ Plane  Display       ,  Csys Display                 ,    

และ Annotation Element Display   
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	 หลังจากปิดเครื่องมือ plane Display, Csys Display และ Annotation Element Display แล้ว 

หน้าต่างการทำงานจะว่างพร้อมสำหรับการทำงานขั้นต่อไป
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  	 1. คลิก  assemble 

การนำเข้าขวดน้ำ

  	 2. เลือกชิ้นงาน ในที่นี้คือ bottle.prt แล้วคลิกปุ่ม Open
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  	 3. ที่ dashboard assembly  กำหนดชิ้นงานแรกจะเลือกเป็นค่า Default 

 	  4. คลิก         เพื่อสิ้นสุดการนำขวดน้ำมาใช้ในการประกอบชิ้นงาน 

เมื่อชิ้นงานขวดถูกนำเข้ามาใช้บนพื้นที่ทำงานแล้ว  จะปรากฏหน้าต่าง Dashboard  assembly 

ด้านบนของพื้นที่ทำงานที่ต้องทำการปรับแต่งข้อกำหนดต่างๆ
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  	 1. คลิก  assemble 

การนำเข้าฝาขวด 

 	 2. เลือกฝาขวด ในที่นี้คือ  cap.prt  คลิก Open

เมื่อนำฝาเข้ามาประกอบชิ้นงาน ฝาอาจอยู่ในตำแหน่งที่ไม่สะดวกในการทำงาน ดังภาพ
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ทำการย้ายฝาขวดให้อยู่ในตำแหน่งที่สะดวกในการทำงานโดยกดปุ่ม 3 ปุ่มค้างไว้ คือ  Ctrl + Alt 

และปุ่มขวาของเมาส์   แล้วเลื่อนเมาส์ (Drag) เพื่อนำฝาขวดไปไว้ในตำแหน่งที่ต้องการ

ในกรณีที่ฝาขวดอยู่ในมุมที่ไม่ตรงตามต้องการอาจปรับความเอียงของฝาขวดได้โดยการกดปุ่ม 3 ปุ่ม 

ค้างไว้คือ ctrl + Alt และปุ่มกลางของเมาส์ แล้วเลื่อนเมาส์ (Drag) ฝาขวดจะปรับเอียงตามต้องการ
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 	 3. จับคู่พื้นผิวด้านในของฝาขวด และผิวด้านในของปากขวด โดยการคลิกผิวด้านในของฝาขวด  

แล้วนำเมาส์มาคลิกที่ผิวด้านในของปากขวดจะทำให้จุดกึ่งกลางของฝาและปากขวดตรงกัน

 	 4. จับคู่ผิวของชิ้นงานคู่ต่อไป (ในที่นี้คือ ผิวด้านบนของขวด กับ ผิวด้านล่างของฝาขวด) 

โดยทำตามขั้นตอนต่อไปนี้

 		  4.1. คลิกเมาส์ลงบนผิวด้านบนของขวด แล้วเลื่อนเมาส์ออกมานอกชิ้นงาน    เนื่องจาก

มุมมองนี้ไม่สะดวกในการเลือกผิวหน้าด้านล่างของฝาขวด          ต้องปรับมุมมองของชิ้นงานเพื่อความ

เหมาะสมในการทำงานขั้นต่อไป โดยคลิกปุ่มกลางของเมาส์แล้วเลื่อนเมาส์ (Drag) เพื่อปรับมุมมองใหม่ 

ให้เห็นด้านล่างของฝาขวด
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 		  4.2. คลิกเมาส์ลงบนขอบของฝาขวด   เพื่อเลือกจับคู่ด้านบนของขวดกับด้านล่าง 

ของฝาขวดให้ครบสมบูรณ์

 	 5. กำหนดระยะห่างระหว่างขอบล่างของฝาขวดกับผิวด้านบนของขวด  โดยคลิกรูปแบบ 

ของการจับคู่ (Mate) เป็นแบบกำหนดระยะห่างด้วยตนเอง 		
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 	 7. บันทึกงานไว้โดยคลิกที่ปุ่ม Save          จะปรากฏหน้าต่าง 

Save แสดงแหล่งเก็บและชื่อไฟล์งาน ตรวจสอบให้ถูกต้องแล้วคลิก  

 	 6. กำหนดระยะห่างโดยการพิมพ์ตัวเลข 5  กดปุ่ม Enter บนแป้นพิมพ์ แล้วคลิกปุ่ม    

เพื่อยอมรับการเปลี่ยนแปลง  
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บทที่5
การเขียนแบบ

       	 การเขียนแบบเป็นการแสดงรายละเอียด  ของแต่ละส่วน

ประกอบ ของชิ้นงาน  ซึ่งเป็นการนำไปสู่ขั้นตอนการผลิตชิ้นงาน  

มีขั้นตอนโดยสรุปดังนี้

	 1. สร้างไฟล์ใหม่  เลือกไฟล์ชิ้นงานที่ต้องการเขียนแบบ 

และเลือกรูปแบบของกระดาษเขียนแบบ

	 2. กำหนดตำแหน่ง มุมมองของชิ้นส่วน 

และรูปแบบการแสดงภาพ

	 3. เพิ่มภาพฉาย (Projection) และรูปแบบการแสดงภาพ

	 4. แสดงขนาดของชิ้นส่วน

- การสร้างไฟล์เขียนแบบ

- รูปแบบกระดาษเขียนแบบ

- ตำแหน่งและมุมมองของชิ้นงาน

- การเพิ่มภาพฉาย และการแสดงภาพ

- การแสดงขนาดของชิ้นงาน

Chapter
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การสร้างไฟล์ใหม่ เลือกไฟล์ชิ้นงานที่ต้องการเขียนแบบ  

	 1. คลิกไอคอน          ซึ่งจะพบหน้าต่างโต้ตอบ เลือก Drawing  

ตั้งชื่อ bottle_draw  คลิก OK

	 2.  ที่หน้าต่างโต้ตอบ    เลือกไฟล์

ชิ้นงานที่ต้องการเขียนแบบ และเลือก

รูปแบบของกระดาษเขียนแบบแล้วดำเนิน

การตามขั้นตอนต่อไปนี้

		  2.1. คลิกปุ่ม Browse ที่ 

Default  Model เพื่อเข้าสู่ขั้นตอนในการ 

นำไฟล์ชิ้นงานมาใช้ในการเขียนแบบ 

และการเลือกรูปแบบของกระดาษเขียนแบบ
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 			      2.2. เลือกชิ้นงาน  bottle_assembly.asm   แล้วคลิกปุ่ม Open

 	 3. การเลือกรูปแบบของกระดาษเขียนแบบ เป็นขั้นตอนที่มีความสำคัญเพราะกระดาษที่ใช ้

ในการเขียนแบบมีหลายขนาด รวมทั้งมีรูปแบบที่กำหนดไว้แตกต่างกัน  ขั้นตอนนี้กำหนดค่าที่หน้าต่าง 

โต้ตอบเดียวกันดังต่อไปนี้

	  		  3.1. คลิกเลือก Empty with format คือเลือกกระดาษเปล่าที่มีรูปแบบเฉพาะ 

สำหรับการเขียนแบบ
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 	 3.2. คลิกปุ่ม Browse… ที่ Format 

	 4. เลือกรูปแบบกระดาษสำหรับใช้ในการเขียนแบบ  คลิกเลือก a4_landscape.frm  แล้วคลิก

ปุ่ม Open

		  หลังจากปรับแต่งข้อกำหนดต่างๆ แล้ว หน้าต่าง 

โต้ตอบจะมีลักษณะดังภาพต่อไปนี้ ให้คลิกปุ่ม OK
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การกำหนดตำแหน่ง มุมมองของชิ้นส่วน

	 การกำหนดตำแหน่ง มุมมองของชิ้นส่วน และรูปแบบการแสดงภาพ   ในที่นี้ต้องการนำเสนอภาพ

ของชิ้นงานในมุมมองต่างๆ ในกระดาษเขียนแบบในลักษณะดังต่อไปนี้

	 หลังจากคลิกปุ่ม OK จะมีลักษณะดังภาพต่อไปนี้ ซึ่งเป็นหน้าต่างที่พร้อมสำหรับการเขียนแบบ

และรูปแบบการแสดงภาพ
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	 1. คลิกปุ่ม General (Create a general view)             เพื่อนำชิ้นส่วนเข้ามาแสดง

บนกระดาษเขียนแบบ ในที่นี้จะเป็นภาพมุมมอง Isometric

ขั้นตอนการทำงาน มีดังต่อไปนี้

 	 หลังจากคลิกปุ่ม General แล้วจะพบหน้าต่าง Select combined state ให้คลิกปุ่ม OK
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	 2. กำหนดตำแหน่งของภาพโดยคลิกลงบนกระดาษเขียนแบบตามที่กำหนดไว้คือใกล้มุมบนซ้าย   

หลังจากคลิกเมาส์ลงบนกระดาษเขียนแบบตรงตามตำแหน่งที่ต้องการ โปรแกรมจะแสดงหน้าต่างโต้ตอบ 

สำหรับการกำหนดมุมมอง

	 3. เลือกมุมมองของภาพ ในที่นี้ต้องการมุมมองแบบ Isometric  โดยทำตามลำดับต่อไปนี้

  	 3.1. เลือก View Type  ในช่อง  Categories

 	 3.2. เลือก ISOMETRIC ในช่องตัวเลือก  

Model view names

	 3.3. คลิกปุ่ม  OK
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  	 หลังจากคลิกเลือกมุมมองเป็บแบบ Isometric ภาพของชิ้นส่วนที่นำมาใช้ในการเขียนแบบ 

จะปรับเปลี่ยนมุมมองเป็นแบบ Isometric ดังภาพ

 	  โดยปกติแล้วเมื่อวางภาพลงบนกระดาษเขียนแบบแล้วโปรแกรมจะตรึงตำแหน่งของภาพไว้

ถ้าต้องการ ย้ายภาพจากตำแหน่งเดิม ให้คลิกขวาค้างที่ภาพ โปรแกรมจะแสดงแถบคำสั่ง  

แล้วปลดเครื่องหมายหน้าคำสั่ง Lock View Movement ออก จึงจะสามารถเคลื่อนย้ายภาพ 

ออกจากตำแหน่งเดิมได้
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	 4. เพิ่มมุมมองชิ้นงานใหม่ลงบนกระดาษทำงาน ในที่นี้ต้องการมุมมอง Front   และกำหนด 

รูปแบบของการแสดงภาพเป็นแบบลายเส้น และใช้เป็นแบบเริ่มต้นสำหรับใช้ในการเขียนภาพฉาย 

ในมุมมองอื่นๆ โดยการคลิกขวาค้างบนพื้นที่ว่างบนกระดาษเขียนแบบ รอจนกว่าหน้าต่างคำสั่งจะแสดง 

ขึ้นมา แล้วเลือกคำสั่ง Insert General View

	 5. คลิกเมาส์ลงบนพื้นกระดาษเขียนแบบในตำแหน่งที่ต้องการ  จะปรากฏหน้าต่างสำหรับการ 

กำหนดมุมมองของภาพ ซึ่งต้องปรับแต่ง  ในที่นี้ต้องการแสดงภาพในมุมมอง Front  ทำได้โดยการคลิก 

เลือก View Type ในช่อง Categories แล้วเลือก FRONT ในช่อง Model view name 

ต่อจากนั้นคลิกปุ่ม Apply
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 	 ภาพจะเปลี่ยนมุมมองเป็นมุมมอง Front  ดังภาพ 

 	 6.  แสดงภาพเป็นแบบลายเส้น โดยคลิกเลือก View Display ในช่อง Categories แล้วเลือก   

Display Style เป็นแบบ No Hidden แล้วกดปุ่ม OK
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การเพิ่มภาพฉาย (Projection) และรูปแบบการแสดงภาพ

	 การเพิ่มภาพฉาย (Projection) เป็นขั้นตอนที่ทำต่อเนื่องจากขั้นตอนที่ผ่านมาโดยจะใช้

ภาพจากขั้นตอนที่ผ่านมาคือจากภาพมุมมอง Front ในที่นี้ต้องการภาพมุมมอง Left  และ Top 

ขั้นตอนการทำงานมีดังนี้

	 เลื่อนเมาส์ออกมาทางด้านขวาของภาพ  ในขณะนี้ปลายเมาส์จะมีลักษณะเป็นรูปสี่เหลี่ยม   

เมื่อตรงตามตำแหน่งที่ต้องการแล้วให้คลิกเมาส์ลงบนกระดาษเขียนแบบ

	 1. เพิ่มภาพมุมมอง Left โดยคลิก 

เมาส์ขวาค้างบนภาพมุมมอง Front 

ที่ได้จากขั้นตอนที่แล้ว รอจนกระทั่งโปรแกรม 

แสดงหน้าต่างคำสั่ง 

เลือก Insert Projection View….
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 	 2. ปรับการแสดงภาพเป็นแบบลายเส้นโดยคลิกขวาค้างบนภาพ แล้วเลือกคำสั่ง Properties

 	 คลิก View Display จากช่อง Categories  เลือก Display style เป็นแบบ  No Hidden 

แล้วคลิกปุ่ม OK
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 	 3. เพิ่มภาพมุมมอง Top โดยคลิกขวาค้างบนภาพมุมมอง Front ที่ได้จากขั้นตอนที่แล้ว  

รอจนกระทั่งโปรแกรมแสดงหน้าต่างคำสั่ง เลือก Insert Projection View….

	 เลื่อนเมาส์ออกมาทางด้านล่างของภาพ  ในขณะนี้ปลายเมาส์จะมีลักษณะเป็นรูปสี่เหลี่ยม   

เมื่อตรงตามตำแหน่งที่ต้องการแล้วให้คลิกเมาส์ลงบนกระดาษเขียนแบบ
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 	 4. ปรับการแสดงภาพเป็นแบบลายเส้นโดยคลิกขวาค้างบนภาพ แล้วเลือกคำสั่ง Properties

 	 ปรับแต่งโดยเลือก View Display จากช่อง Categories  เลือก Display style เป็นแบบ   

No Hidden แล้วคลิกปุ่ม OK
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การแสดงขนาดของชิ้นส่วน

	 ตัวอย่างการแสดงขนาดของตัวขวดไม่รวมฝาขวดมีขั้นตอนดังนี้

 		

            1. คลิกปุ่ม Show Erase   
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 		  2. ปรับขนาดโดยคลิกเครื่องมือ Dimension

         3. นำเมาส์ไปคลิกบนชิ้นส่วนที่แสดงบนกระดาษเขียนแบบหลังจากคลิกเมาส์ลงบนขวดแล้ว 

โปรแกรมจะแสดงขนาดของชิ้นส่วน ทั้งความสูง  ความกว้าง รวมทั้งขนาดเส้นผ่านศูนย์กลาง

ของวงกลม ที่ใช้ในการขึ้นรูป ชิ้นงาน ดังภาพทางด้านบน

	 เมื่อไม่ต้องการแสดงขนาดของชิ้นส่วนใดแล้วให้คลิกปุ่ม Cancel เพื่อเลิกใช้เครื่องมือ 

แล้วคลิกปุ่ม Close เพื่อปิดหน้าต่าง Show/Erase
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	 ขั้นตอนของการแสดงขนาดความสูงของขวดรวมทั้งฝาขวด มีขั้นตอนดังนี้

		  1. คลิกปุ่ม New References           เพื่อแสดงขนาดแบบกำหนดเอง

	  	 2. คลิกเมาส์ที่เส้นบนสุดของฝาขวด (X1) และเส้นล่างสุดของขวด (X2) ต่อจากนั้น 

เลื่อนเมาส์ไปยังตำแหน่งที่ต้องการแสดงตัวเลขบอกความสูง (X3) แล้วคลิกปุ่มกลางบนเมาส์

เลิกการใช้งานโดยคลิกปุ่ม Cancel 

การแสดงความสูงของขวด
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หลังจากกำหนดขนาดของชิ้นส่วนครบตามต้องการจะได้ดังภาพต่อไปนี้
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บทที่6
ตัวอย่างการสร้างชิ้นงาน

Chapter

- การสร้างภาพตัดขวาง

- การสร้างมือหมุนรางเลื่อน

- การขึ้นรูปชิ้นงานโดยวิธี Sweep   

- สปริง    

- การสร้างตู้ที่มีลิ้นชัก

- การสร้างชิ้นงานรูปน็อตโดยใช้ Helical Sweep

- การประกอบชุดเฟืองทดรอบ

- การสร้างชิ้นงานเครื่องบิน

- ชิงช้า...ลั้นล้า...

- พัดลมมือถือ

- โมเดลรถยนต์



130

1.  ในโปรแกรม Pro/Engineer เปิดชิ้นงานที่ต้องการสร้างภาพตัดขวาง

การสร้างภาพตัดขวาง

2.  คลิกปุ่ม View Manager



131

3.  เลือก  Xsec

4. กำหนดชื่อมุมมองภาพตัดขวาง 

      โดยคลิก ปุ่ม New

     

 ตั้งชื่อสำหรับมุมมองภาพตัดขวาง

ในที่นี้กำหนดเป็น cut แล้ว Enter
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5.  คลิกปุ่ม Done

6.  เลือก Plane ที่ต้องการ

ให้เป็นแกนในการตัดขวาง
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7.  ดับเบิลคลิกที่ชื่อของมุมมองที่กำหนดไว้จากข้อ 4

จะปรากฏผลดังรูป

8. กลับไปมุมมองปกติให้ ดับเบิลคลิกที่ No Cross Section  

แล้วคลิก Close
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	  เพื่อสร้างชิ้นงานที่มีลักษณะเป็นลูกเลื่อนที่สามารถขยับไปบนราง โดยการหมุนมือหมุน 

     และจำลองการใช้งานโดยใช้มอเตอร์เป็นต้นกำลัง

การสร้างมือหมุนรางเลื่อน

1. สร้างชิ้นงานจำนวน 4 ชิ้น ได้แก่

 	 1) ฐาน สร้างด้วยกระบวนการ Extrude และเจาะรูสำหรับประกอบข้อเหวี่ยง

	 2) ก้านชัก สร้างด้วยกระบวนการ Extrude

	 3) ลูกเลื่อน สร้างด้วยกระบวนการ Extrude

	 4) ข้อเหวี่ยง สร้างด้วยกระบวนการ Extrude

2. ประกอบลูกเลื่อนกับก้านชัก

3. นำชิ้นส่วนที่ประกอบด้วยลูกเลื่อนกับก้านชักที่ประกอบไว้แล้วมาประกอบเป็นชิ้นงานสำเร็จ

การวางแผนสร้างชิ้นงาน

เป้าหมาย

     โดย นายธนกฤต เดชนาเกร็ด ศึกษานิเทศก์ สพท.ศรีสะเกษ เขต 3
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	 4. กำหนดรูปแบบการ Extrude แบบสมมาตร ขนาด 200.00

	 5. การเจาะรู บนผิวของชิ้นงาน

	 1. สร้างไฟล์ใหม่โดยเลือกรูปแบบของงานเป็นแบบ Part

	 2. เลือกฟีเจอร์ Extrude และเลือก plane ตามต้องการ

	 3. เขียนแบบและกำหนดขนาดของชิ้นงานดังภาพ

การสร้างฐาน (ชิ้นส่วนที่ 1)

1.  ในโปรแกรม Pro/Engineer เปิดชิ้นงานที่ต้องการสร้างภาพตัดขวาง

ขั้นตอนการสร้าง
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คลิกเมาส์บนผิวในของชิ้นงาน

ลากจุดสีเขียววางไว้บนขอบของชิ้นงานจุดละด้าน

กำหนดระยะห่างจากขอบบน 10.00

กำหนดเส้นผ่านศูนย์กลาง 10.00 

กำหนดความลึกให้เกินความหนาของชิ้นงาน

กำหนดระยะห่างจากขอบ 10.00 
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ขั้นตอนการทำงานมีดังนี้

	 1. สร้างไฟล์ใหม่โดยเลือกรูปแบบของงานเป็นแบบ Part

	 2. เลือกฟีเจอร์ Extrude และเลือก plane ตามต้องการ

	 3.  Sketch รูปวงกลม 2 วงขนาด 15.00 และ 10.00 ใช้้จุดศูนย์กลางเดียวกัน   

จำนวน 2 ชุด ห่างกัน 80.00  แล้วตัดเส้นที่ไม่ต้องการออก

	 4. สร้างความหนาขนาด 10.00

การสร้างก้านชัก (ชิ้นส่วนที่ 2)
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การสร้างลูกเลื่อน (ชิ้นส่วนที่ 3)

	 4. สร้างความหนาขนาด  80.00 

	 5. สร้างปุ่มสำหรับยึดเกาะกับก้านชัก  

บนพื้นผิวของ ลูกเลื่อนด้วย Extrude Feature  

ลักษณะเป็นแกนทรงกระบอก เส้นผ่านศูนย์กลาง  

10.00 ความสูง 10.00

การสร้างลูกเลื่อนมีขั้นตอนดังนี้

	 1. สร้างไฟล์ใหม่โดยเลือกรูปแบบของงานเป็นแบบ Part

	 2. เลือกฟีเจอร์ Extrude และเลือก plane ตามต้องการ

	 3. สร้างรูปสี่เหลี่ยมขนาด 40.00 X 60.00  
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การสร้างข้อเหวี่ยง (ชิ้นส่วนที่ 4)

การสร้างข้อเหวี่ยงมีขั้นตอนดังนี้

	 1. สร้างไฟล์ใหม่โดยเลือกรูปแบบของงานเป็นแบบ Part

	 2. เลือกฟีเจอร์ Extrude และเลือก plane ตามต้องการ

	 3. วาดวงกลมขนาด 10.00 จำนวน 2 วง  ให้อยู่ห่างกัน 40.00  

แล้วเชื่อมต่อกันด้วยเส้นสัมผัส แล้วตัดเส้นที่ไม่ต้องการออก

 

	 4. สร้างความหนาขนาด 10.00

	 5. สร้างแกนของข้อเหวี่ยงบนผิวชิ้นงาน โดยใช้ฟีเจอร์ Extrude ลักษณะ 

เป็นทรงกระบอก เส้นผ่านศูนย์กลาง 10.00  ยาว 50.00 
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วาดวงกลมขนาด 10.00

คลิก Done

กำหนดขนาดการ Extrude 50.00

สร้างวงกลมขนาด 10.00

กำหนดขนาด Extrude 10.00

คลิก Done
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การประกอบชิ้นงานมือหมุนรางเลื่อน

	 การประกอบชิ้นงานมือหมุนรางเลื่อนในตัวอย่างนี้ดำเนินการ 2 ขั้นตอน ขั้นตอนแรก 

เป็นการประกอบลูกเลื่อนและก้านชัก ขั้นตอนที่สองเป็นการนำชิ้นงานลูกเลื่อนและก้านชักที่ประกอบ

กันแล้วมาประกอบเป็นชิ้นงานสำเร็จตามที่ต้องการ

 
การประกอบลูกเลื่อนและก้านชัก

	 1. สร้างไฟล์ใหม่ (Assembly) แล้วนำลูกเลื่อนเข้ามาเป็นอันดับแรกใช้เป็นชิ้นส่วนหลัก 

(Default)

	 คลิกไฟล์ชิ้นส่วนลูกเลื่อนส่วนหลัก  

	 คลิก OPEN

	 กำหนดเป็น Default
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	 2. นำเข้าก้านชักมาประกอบชิ้นงาน แบบ Pin 

 

	 คลิกไฟล์ก้านชัก 

	 คลิก OPEN

	 เลือกรูปแบบ Pin

จับคู่ผิวรูของก้านชัก

กับแกนของลูกเลื่อน
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	 จับคู่ผิวหน้าก้านชักและผิวหน้า

ของลูกเลื่อนที่ต้องการให้แนบชิดติดกัน



144

การประกอบชิ้นส่วนมือหมุนและรางเลื่อน

	 การประกอบชิ้นงานมือหมุนรางเลื่อนขั้นตอนต่อไปนี้เป็นการนำชิ้นส่วนที่ได้ประกอบ 

ไว้แล้วมาประกอบเป็นชิ้นงานที่มีความสมบูรณ์ตามความมุ่งหมายที่กำหนดไว้ ขั้นตอนสำหรับ 

การประกอบชิ้นงานมีดังต่อไปนี้

	 1. สร้างไฟล์ใหม่ ในรูปแบบ Assembly แล้วนำเข้าไฟล์ฐานเข้ามาเป็นชิ้นส่วนแรก 

ใช้เป็นชิ้นส่วนหลัก (Default)

คลิก OPEN

กำหนดเป็น Default

คลิกไฟล์ฐาน
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คลิกไฟล์มือหมุน

คลิก OPEN

2. นำเข้าชิ้นส่วนมือหมุนมาประกอบชิ้นงาน แบบ Pin 

เลือกรูปแบบ Pin

จับคู่ผิวนอกของก้านมือหมุน

กับผิวของรูบนฐาน

n
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จับคู่ผิวหน้าของฐานกับผิวหน้าของมือหมุน

ในส่วนที่ต้องแนบชิดกันตลอดเวลา

ชิ้นส่วนที่ประกอบแล้วในขั้นต้น
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	 2. นำเข้าชิ้นส่วนของลูกเลื่อนและก้านชักที่ประกอบไว้แล้วมาประกอบกับชิ้นงานนี้ 

โดยมีการประกอบ 2 ครั้ง ครั้งแรกแบบ Slider โดยทำตามลำดับต่อไปนี้

คลิกไฟล์ลูกเลื่อนและก้านชัก

ที่ประกอบไว้แล้ว

คลิก OPEN

เลือกแบบ Slider เลือกแบบ Slider

จับคู่มุมล่างของลูกเลื่อนกับมุมของรางเลื่อน

(ซึ่งมุมนี้จะสัมผัสกันตลอดเวลา)
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คลิกไฟล์ลูกเลื่อนและก้านชัก

ที่ประกอบไว้แล้ว

จับคู่ด้านนอกของลูกเลื่อน 

และด้านข้างของรางเลื่อน 

(ซึ่งเป็นด้านที่สัมผัสกันตลอดเวลา)

3. ประกอบชิ้นส่วนครั้งที่สองจากชิ้นส่วนที่นำเข้ามาแบบ Cylinder โดยทำตามลำดับต่อไปนี้

คลิก Placement
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คลิก New Set

เลือก Cylinder

จับคู่ขอบนอกของก้านมือถือ 

และผิวในของรู ที่ก้านชัก 

ซึ่งจะสัมผัสกันตลอดเวลา
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คลิก Applies

จำลองการทำงานโดยใช้มอเตอร์เป็นต้นกำลัง

 	 การจำลองการทำงานสำหรับงานชิ้นนี้จะใช้มอเตอร์เป็นต้นกำลังในการทำงาน ขั้นตอนกา

รจำลองการทำงานมีดังต่อไปนี้

	 1. ปรับโหมดการทำงานเป็นแบบ Mechanism โดยเลือกคำสั่ง Applications >  

Mechanism
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2. ติดตั้งมอเตอร์ โดยทำตามลำดับต่อไปนี้

 

คลิกเลือกมอเตอร์ คลิกที่ลูกศรของแกนมือหมุน
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3. กำหนดการทำงานของมอเตอร์ โดยทำตามขั้นตอนตามลำดับต่อไปนี้

คลิกเลือกแท็บ Profile

 

เลือกรูปแบบ

Velocity

กำหนดอัตราการหมุน (องศา/วินาที)

ในที่นี้กำหนดเป็น 60 องศาต่อวินาที คลิก OK
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	 4. วิเคราะห์การทำงานก่อนแสดงการทำงานจริง มีขั้นตอนตามลำดับดังนี้

คลิกปุ่มวิเคราะห์การทำงาน

กำหนดเวลาสิ้นสุดการทำงาน ในที่นี้กำหนด

ด้วยตัวเลข 12 ซึ่งมาจากอัตราการหมุน

 60 องศาต่อวินาที ดังนั้นการกำหนด 

12 วินาที จึงทำให้มีการหมุนครบ 2 รอบพอดี 

คลิก Run เพื่อให้โปรแกรมวิเคราะห ์

การทำงานต่อจากนั้นคลิกปุ่ม OK 

เพื่อปิดหน้าต่างนี้
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	 5. แสดงการทำงาน โดยทำตามลำดับต่อไปนี้

คลิกปุ่ม Play

คลิกปุ่ม Play เพื่อแสดง 

เครื่องมือแสดงการทำงาน

คลิกปุ่มเล่น เพื่อแสดงการทำงาน

สามารถกำหนดความเร็วได้โดยการปรับ 

Speed
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1. สร้างชิ้นงานใหม่ รูปแบบ Part  ต่อจากนั้นคลิกคำสั่ง Insert> Sweep > Protrusion...

การขึ้นรูปชิ้นงานโดยวิธี Sweep
     โดย นายธนกฤต เดชนาเกร็ด ศึกษานิเทศก์ สพท.ศรีสะเกษ เขต 3

 	 สร้างชิ้นงานโดยวิธี Sweep ซึ่งสามารถประยุกต์ใช้ในการสร้างงาน

 เช่น โครงโต๊ะ  โครงเก้าอี้ เป็นต้น

		  1. สร้างชิ้นงานใหม่ รูปแบบ Part 

		  2. สร้างชิ้นงานโดยใช้ฟีเจอร์ Sweep 

การวางแผนสร้างชิ้นงาน

เป้าหมาย

ขั้นตอนการสร้าง
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2. กำหนดรายละเอียดของการ Sweep

คลิก Sketch Traj

คลิก Front

 	 สร้างชิ้นงานโดยวิธี Sweep ซึ่งสามารถประยุกต์ใช้ในการสร้างงาน

 เช่น โครงโต๊ะ  โครงเก้าอี้ เป็นต้น
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คลิก Okay คลิก Default

วาดเส้นตามต้องการ

คลิก Done



158

วาดภาพหน้าตัด 

ของชิ้นงานบนจุดตัด

คลิก Done

คลิก Preview 
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1. สร้างชิ้นงานใหม่  

สปริง (Spring)

คลิก Done

กำหนดชื่อ

คลิก OK

     โดย นายธนกฤต เดชนาเกร็ด ศึกษานิเทศก์ สพท.ศรีสะเกษ เขต 3

 	 เพื่อสร้างชิ้นงานรูปสปริง

		  1. สร้างชิ้นงานใหม่ แล้ว Insert > Helical Sweep > Protrusion…

	  	 2. กำหนดรายละเอียดของสปริง

การวางแผนสร้างชิ้นงาน

เป้าหมาย

ขั้นตอนการสร้าง
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2. คลิกคำสั่ง Insert > Helical Sweep > Protrusion…

3. กำหนดรายละเอียดของสปริง

คลิก Done
คลิก Rront

คลิก OK

 	 เพื่อสร้างชิ้นงานรูปสปริง
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คลิก Default

วาดเส้นตรงจากด้านล่างขึ้นด้านบน

ความยาว 200.00 ห่างจากเส้นแกนกลาง 

แนวดิ่ง  30.00

คลิกเครื่องมือวาดเส้น

เปลี่ยนเครื่องมือวาดเส้น 

เป็นเครื่องมือวาดแกนกลาง
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วาดเส้นแกนกลางของสปริง

คลิก Done

กำหนดความห่างของขดสปริง

คลิก Applies
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คลิกเครื่องมือวาดวงกลม 

วาดวงกลมเส้นผ่านศูนย์กลาง 10.00

(บนจุดตัดที่เป็นจุดเริ่มต้นของเส้น

ที่วาดไว้ในขั้นตอนแรก)

คลิก Done

คลิก Preview เพื่อดูภาพสปริง

เมื่อตรงตามต้องการคลิก OK
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ตัวอย่างการสร้างงานด้วยโปรแกรม
ศึกษารายละเอียดได้จากแผ่นซีดีแผ่นที่ 3
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การสร้างตู้ที่มีลิ้นชัก  

 	 นายธนกฤต เดชนาเกร็ด   		

ครูโรงเรียนสุธีวิทยา สพท.สระบุรี เขต 1

ศึกษานิเทศก์  สพท.ศรีสะเกษ  เขต 3

	 นางทิพวรรณ แดงมาก 
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การสร้างชิ้นงานรูปน็อตโดยใช้เครื่องมือ Helical Sweep    

นาย รติ พิพัฒน์ศรี  
ครูโรงเรียนเบญจมราชรังสฤษฎิ์ 2  สพท.ฉะเชิงเทรา เขต 1

ประกอบชุดเฟืองทดรอบ   

นายไตรรัตน์  เชื้อทองพิทักษ์    
ครูโรงเรียนกันทรารมณ์  สพท.ศรีสะเกษ เขต 1
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  การสร้างชิ้นงานเครื่องบิน    

นายพิทักษ์เกียรติ  บรรเทา        
ครูโรงเรียนนาแกสามัคคีวิทยา   สพท.นครพนม เขต 1

ชิงช้า...ลั้นลา...   

นางสาวชวาลี  อินทะนา        

ครูโรงเรียนพร้าววิทยาคม  สพท.เชียงใหม่ เขต 2



168

พัดลมมือถือ    

นางสาววรนุช  แสงจันทร์          

ครูโรงเรียนบ่อทองวงษ์จันทร์วิทยา สพท.ชลบุรี  เขต 2

นายธีรยุทธ  ศรีตระกูล          

ครูโรงเรียนเมืองพญาแลวิทยา  สพท.ชัยภูมิ เขต 1

โมเดลรถยนต์



ภาคผนวก
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แผ่น CD ประกอบเอกสาร

แผ่นที่ 1 และ 2  บรรจุโปรแกรม Pro/ENGINEER Wildfire 4.0 Schools Edition

ใช้ในการติดตั้งโปรแกรมลงเครื่องคอมพิวเตอร์

แผ่นที่ 3  รายละเอียดการใช้งานโปรแกรม  ประกอบด้วย

      ไฟล์เอกสาร คู่มือการพัฒนาการจัดการเรียนการสอน การออกแบบผลิตภัณท์

กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยีด้วยโปรแกรม Pro|ENGINEER

      ไฟล์เอกสารรายละเอียดการสร้างงาน

	 - การสร้างตู้ที่มีลิ้นชัก  

	 - การสร้างชิ้นงานรูปน็อตโดยใช้เครื่องมือ Helical Sweep  

	 - ประกอบชุดเฟืองทดรอบ   

	 - การสร้างชิ้นงานเครื่องบิน    

	 - ชิงช้า...ลั้นลา...   

	 - พัดลมมือถือ   

	 - โมเดลรถยนต์
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ที่ปรึกษา

คุณหญิงกษมา  วรวรรณ ณ อยุธยา 	 เลขาธิการคณะกรรมการการศึกษาขั้นพื้นฐาน	

นายวินัย  รอดจ่าย			   รองเลขาธิการคณะกรรมการการศึกษาขั้นพื้นฐาน

ดร.อรทัย  มูลคำ				   ผู้อำนวยการสำนักพัฒนานวัตกรรมการจัดการศึกษา

นายอภิชาต พุทธเจริญ			   ศึกษานิเทศก์ ช่วยราชการ สำนักพัฒนานวัตกรรมการจัดการศึกษา

ผู้ร่วมเรียนการใช้งานโปรแกรมจากวิทยากรบริษัท

นายอดุลย์  วงศ์ใหญ่		  ศึกษานิเทศก์	 ช่วยราชการ สำนักพัฒนานวัตกรรมการจัดการศึกษา

นายจงภพ  ชูประทีป		  ศึกษานิเทศก์      สพท.เชียงใหม่ เขต 1

นายอานนท์  วงศ์วิศิษฏ์รังสี	 ศึกษานิเทศก์	 สพท.อุบลราชธานี เขต 1

นายไพรวัลย์ วันทนา 		  ศึกษานิเทศก์	 สพท.นครราชสีมา เขต 1

นายชาญชัย  ชื่นพระแสง		 ศึกษานิเทศก์  	 สพท.สุราษฎร์ธานี เขต 1

นายอรัณย์  อัจฉรานิวัฒน์		 ศึกษานิเทศก์	 สพท.ฉะเชิงเทรา เขต 1

นายธนกฤต  เดชนาเกร็ด		 ศึกษานิเทศก์	 สพท.ศรีสะเกษ เขต 3

น.ส.เกษร  มงคล			  ศึกษานิเทศก์	 สพท.ฉะเชิงเทรา เขต 1

นายอนนท์  ศรีพิพัฒน์		  ศึกษานิเทศก์	 สพท.นครปฐม  เขต 2

น.ส.เอื้อมพรพิชญ์ จันทน์แดง	 ศึกษานิเทศก์	 สพท.อุดรธานี  เขต 1

นายจำรัส  สอนกล้า		  ศึกษานิเทศก์	 สพท.สุรินทร์  เขต 1

นายดนัย  ไกรสร			  ครูโรงเรียนบ้านห้วยไร่สามัคคี   สพท.เชียงราย  เขต 3

นางทิพวรรณ  แดงมาก		  ครูโรงเรียนสุธีวิทยา   สพท.สระบุรี  เขต 1

นายสุริยันต์ สีแก้ว 		  ครูโรงเรียนโนนสูงศรีธานี   สพท.นครราชสีมา  เขต 1

นายอลงกรณ์  ยุวเดชกุล		  ครูโรงเรียนเสิงสาง  สพท.นครราชสีมา  เขต 3

นายไชยรัตน์ เอี่ยมแบน  		  ครูโรงเรียนสตรีศึกษา 2  สพท.ร้อยเอ็ด  เขต 1

ว่าที่ รต.สมปอง เอมรัตน์		  ครูโรงเรียนสวงษ์วิทยาคม  สพท.ศรีสะเกษ เขต 3

นายสุกิจ  แขวงโสภา		  ครูโรงเรียนประจวบวิทยาลัย  สพท.ประจวบคีรีขันธ์  เขต 1

นายอนุโรจน์   บุญดิลก		  ครูโรงเรียนสวรรคอนันต์วิทยา  สพท.สุโขทัย  เขต 2

น.ส.นิดธิดา สีสะอาด		  ครูโรงเรียนพุทธิรังสีพิบูลย์ สพท.ฉะเชิงเทรา

นายปรัชญ์  พุ่มพึ่งพุทธ		  สำนักพัฒนานวัตกรรมการจัดการศึกษา
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วิทยากรในการพัฒนาครูโรงเรียนในโครงการโรงเรียนฝัน

นายอานนท์  วงศ์วิศิษฏ์รังสี	 ศึกษานิเทศก์	 สพท.อุบลราชธานี เขต 1

นายไพรวัลย์ วันทนา 		  ศึกษานิเทศก์	 สพท.นครราชสีมา เขต 1

นายปกรณ์  วงศ์สวัสดิ์		  ศึกษานิเทศก์	 สพท.ราชบุรี เขต 1

นายธนกฤต  เดชนาเกร็ด		 ศึกษานิเทศก์	 สพท.ศรีสะเกษ เขต 3

นายชาญชัย  ชื่นพระแสง		 ศึกษานิเทศก์  	 สพท.สุราษฎร์ธานี เขต 1

นายอรัณย์  อัจฉรานิวัฒน์		 ศึกษานิเทศก์	 สพท.ฉะเชิงเทรา เขต 1

น.ส.เกษร  มงคล			  ศึกษานิเทศก์	 สพท.ฉะเชิงเทรา เขต 1

น.ส.ดุจดาว  ทิพย์มาตย์		  นักวิชาการศึกษาชำนาญการ   สนก.  สพฐ.

นางทิพวรรณ  แดงมาก		  ครูโรงเรียนสุธีวิทยา   สพท.สระบุรี  เขต 1

นายสุริยันต์ สีแก้ว 		  ครูโรงเรียนโนนสูงศรีธานี   สพท.นครราชสีมา  เขต 1

นายไชยรัตน์ เอี่ยมแบน  		  ครูโรงเรียนสตรีศึกษา 2   สพท.ร้อยเอ็ด  เขต 1

นายสุกิจ  แขวงโสภา		  ครูโรงเรียนประจวบวิทยาลัย  สพท.ประจวบคีรีขันธ์  เขต 1

บรรณาธิการกิจเอกสาร

นายอานนท์  วงศ์วิศิษฏ์รังสี	 ศึกษานิเทศก์	 สพท.อุบลราชธานี เขต 1

นายไพรวัลย์ วันทนา 		  ศึกษานิเทศก์	 สพท.นครราชสีมา เขต 1

นายปกรณ์  วงศ์สวัสดิ์		  ศึกษานิเทศก์	 สพท.ราชบุรี เขต 1

นายธนกฤต  เดชนาเกร็ด		 ศึกษานิเทศก์	 สพท.ศรีสะเกษ เขต 3

นายชาญชัย  ชื่นพระแสง		 ศึกษานิเทศก์  	 สพท.สุราษฎร์ธานี เขต 1

นายทรงเดช  ขุนแท้ 		  ศึกษานิเทศก์ 	 สพท.ปทุมธานี เขต 1

ว่าที่ ร.อ.ศศวรรธน์  ขรรค์ทัพไทย	 ศึกษานิเทศก์  	 สพท.สมุทรปราการ เขต 1 

นางทิพวรรณ  แดงมาก		  ครูโรงเรียนสุธีวิทยา   สพท.สระบุรี  เขต 1

นายสุริยันต์ สีแก้ว 		  ครูโรงเรียนโนนสูงศรีธานี   สพท.นครราชสีมา  เขต 1

นายไชยรัตน์ เอี่ยมแบน  		  ครูโรงเรียนสตรีศึกษา 2   สพท.ร้อยเอ็ด  เขต 1

นายสุกิจ  แขวงโสภา		  ครูโรงเรียนประจวบวิทยาลัย  สพท.ประจวบคีรีขันธ์  เขต 1

น.ส.ดุจดาว  ทิพย์มาตย์		  นักวิชาการศึกษาชำนาญการ   สนก.  สพฐ.
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ตัวอย่างผลงานจากการอบรม

นายไตรรัตน์  เชื้อทองพิทักษ์	 ครูโรงเรียนกันทรารมณ์  สพท.ศรีสะเกษ  เขต 1

นายธีรยุทธ  ศรีตระกูล		  ครูโรงเรียนเมืองพญาแลวิทยา  สพท.ชัยภูมิ  เขต 1

นายพิทักษ์เกียรติ  บรรเทา	 ครูโรงเรียนนาแกสามัคคีวิทยา  สพท.นครพนม เขต 1

นายรติ  พิพัฒน์ศรี		  ครูโรงเรียนเบญจมราษฎร์รังสฤษฎิ์  สพท.ฉะเชิงเทรา  เขต 1

น.ส.วรนุช  แสงจันทร์		  ครูโรงเรียนบ่อทองวงษ์จันทร์วิทยา  สพท.ชลบุรี เขต 2	

น.ส.ชวาลี  อินทะนา		  ครูโรงเรียนพร้าววิทยาคม  สพท.เชียงใหม่ เขต 2

ผู้รับผิดชอบโครงการ

น.ส.ดุจดาว  ทิพย์มาตย์		  นักวิชาการศึกษาชำนาญการ   สนก.  สพฐ.

สพท.กาญจนบุรี เขต 1		 ร.ร.เทพศิรินทร์ลาดหญ้ากาญจนบุรี นางศิวพร คล้ายเจ๊ก

สพท.ขอนแก่น เขต 4		  ร.ร.น้ำพองศึกษา		  นายเกรียงไกร รักษาวงศ์

สพท.ฉะเชิงเทรา เขต 1	 ร.ร.เบญจมราษฎร์รังสฤษฎิ์ 2	 นายรติ พิพัฒน์ศรี

สพท.ชลบุรี	 เขต 2		  ร.ร.บ่อทองวงษ์จันทร์วิทยา	 น.ส.วรนุช แสงจันทร์

สพท.ชัยภูมิ เขต 2		  ร.ร.บ้านแท่นวิทยา		  นางนัยนา ภิรมย์ชม

สพท.เชียงใหม่ เขต 1		  ร.ร.กาวิละวิทยาลัย		  นายกิตตินันท์ อทุมชาย

สพท.เชียงใหม่ เขต 1		  ร.ร.สันกำแพง		  นายนพดล นิมานนท์

สพท.เชียงใหม่ เขต 2		  ร.ร.พร้าววิทยาคม		  น.ส.ชวาลี อินทะนา

สพท.เชียงใหม่ เขต 4		  ร.ร.สารภีพิทยาคม		  นายมนัส พัฒนากร

สพท.ตราด  		  ร.ร.ตราษตระการคุณ		  นายอรุณ กุมภะ

สพท.นครพนม  เขต1		  ร.ร.นาแกสามัคคีวิทยา		 นายพิทักษ์เกียรติ บรรเทา

สพท.นครราชสีมา เขต 1	 ร.ร.โนนสูงศรีธานี		  นางสาวจิราณี เมืองจันทร์

สพท.นครราชสีมา  เขต 2	 ร.ร.โชคชัยสามัคคี		  นายโกเมศ แก้วภา

สพท.นครราชสีมา  เขต 2	 ร.ร.ห้วยแถลงพิทยาคม		 นายณรงค์เดช มะลังศรี

สพท.นครสวรรค์ เขต 1 	 ร.ร.ชุมแสงชนูทิศ		  นายรัฐพล ศิริพิมลวัฒน์

สพท.นครสวรรค์ เขต 2	 ร.ร.ลาดยาววิทยาคม		  นายภูมิภัทร ลอยเจริญ

สพท.บุรีรัมย์ เขต 3		  ร.ร.ละหานทรายรัชดาภิเษก	 นายวีรพันธ์ เสาเคหา

สพท.พระนครศรีอยุธยา เขต 2	 ร.ร.ลาดบัวหลวงไพโรจน์วิทยา	 นายวิรัช บุญนาค

สพท.พะเยา เขต 1		  ร.ร.ฟากกว๊านวิทยาคม		 นางพัชนี ถูกจิตร์

สพท.พัทลุง เขต  2		  ร.ร.หารเทารังสีประชาสรรค์	 น.ส.สุภาวดี จันเกื้อ

สพท.เพชรบุรี  เขต 1		  ร.ร.เขาย้อยวิทยา		  นายวัฒนา มุลกุณี

สพท.เพชรบูรณ์ เขต 3		 ร.ร.ศรีเทพประชาสรรค์		 นายทรงกรด มากมี
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สพท.แพร่	 เขต 1		  ร.ร.สองวิทยาคม		  นายไพฑูลย์ แสนเสนา

สพท.แม่ฮ่องสอน เขต 1	 ร.ร.ศึกษาสงเคราะห์แม่ฮ่องสอน	 นายดำรัส ชัยชนะ

สพท.แม่ฮ่องสอน เขต	 2	 ร.ร.แม่ลาน้อยดรุณสิกข์	 นายสมชาติ มิ่งศรีสุข

สพท.ลำปาง เขต 1		  ร.ร.เสด็จวนชยางค์กูลวิทยา	 นายสิทธิชัย บัตรพิมพ์

สพท.ลำปาง เขต 2		  ร.ร.เถินวิทยา		  นายนพดล ชัยขุนพล

สพท.ลำพูน	 เขต 2		  ร.ร.เวียงเจดีย์วิทยา		  นายนพดล วิจัยคำ

สพท.เลย เขต 1		  ร.ร.เชียงกลมวิทยา		  นายพิษณุวัชร์ สวัสดี

สพท.เลย เขต 3		  ร.ร.ศรีสองรักษ์วิทยา		  นายธงชัย รักษามั่น

สพท.ศรีสะเกษ เขต 1		  ร.ร.กันทรารมณ์		  นายไตรรัตน์ เชื้อทองพิทักษ์

สพท.ศรีสะเกษ เขต 3		  ร.ร.ปรางค์กู่		  นายศุภชัย บุติมาลย์

สพท.สกลนคร เขต 1		  ร.ร.ร่มเกล้า			  นายพิเชษฐ หาญมนตรี

สพท.สงขลา เขต 1		  ร.ร.ระโนดวิทยา		  นายธวัช ศรีไสยเพชร

สพท.สตูล 			  ร.ร.พิมานพิทยาสรรค์		  นายอับดลรอศักดิ์ มณีโส๊ะ

สพท.สระแก้ว เขต 1		  ร.ร.วังน้ำเย็นวิทยาคม		  นายกายสิทธิ์ วาดไธสง

สพท.สระบุรี เขต 1		  ร.ร.หนองแซงวิทยา		  นางจิรัฐติ พิมพ์แสง

สพท.สระบุรี เขต 2		  ร.ร.ประเทียบวิทยาทาน	 นายจักรพงษ์ จันทร์หอม

สพท.สุพรรณบุรี เขต 3		 ร.ร.ธรรมโชติศึกษาลัย		  นายบุญสร้าง เชี่ยวชาญ

สพท.สุพรรณบุรี เขต 3		 ร.ร.หนองหญ้าไซวิทยา		 น.ส.ธารินี ศักดิ์สงคราม

สพท.สุพรรณบุรี เขต 3		 ร.ร.ด่านช้างวิทยา		  นายสมพงษ์ พรมทองดี

สพท.สุพรรณบุรี เขต 3		 ร.ร.สามชุกรัตนโภคาราม	 น.ส.จิราพร รุ่งอร่าม

สพท.สุราษฎร์ธานี เขต	3	 ร.ร.เวียงสระ		  นายสุริยา สารทิพย์

สพท.สุรินทร์ เขต 1		  ร.ร.สำโรงทาบวิทยาคม		 นางดวงตา บุติมาลย์

สพท.สุรินทร์ เขต 2		  ร.ร.สนมวิทยาคาร		  นายพัฒนศักดิ์ พสุนนท์

สพท.สุรินทร์ เขต 3		  ร.ร.พนมดงรักวิทยา		  นางพันธ์นิภา มีศิลป์

สพท.อุตรดิตถ์ เขต 1		  ร.ร.เตรียมอุดมน้อมเกล้า อุตรดิตถ์	นางวาสนา สุวรรณบูลย์

สพท.อุบลราชธานี เขต	4	 ร.ร.วารินชำราบ		  นายประสิทธิ์ สายสุวรรณ

สพท.ร้อยเอ็ด เขต 3		  ร.ร.โพนทองวิทยายน		  นายวีระชัย เลี้ยงวณิชย์

สพท.ยะลา	เขต 3		  ร.ร.เบตง “วีระราษฎร์ประสาน”	 นายศรีไพร พิสิฐนรชัย

สพท.นครศรีธรรมราช	 เขต 4	 ร.ร.สิชลคุณาธารวิทยา		 นายโชคดี ใจแน่

สพท.ศรีสะเกษ เขต 2		  ร.ร.ส้มป่อยพิทยาคม		  นายณัฐพล บัวพันธ์

สพท.นครศรีธรรมราช	 เขต 2	 ร.ร.ทุ่งใหญ่วิทยาคม		  นายจำนงค์ ชัยเพ็ชร

สพท.ลำปาง เขต 1		  ร.ร.แม่เมาะวิทยา		  นายสุวิทย์ โพธิศาสตร์

สพท.ชัยภูมิ เขต 1		  ร.ร.เมืองพญาแลวิทยา		 นายธีรยุทธ ศรีตระกูล

สพท.นครศรีธรรมราช	 เขต 2	 ร.ร.ฉวางรัชดาภิเษก		  นายบัญญัติ ศรีวิสุทธิ์

สพท.ศรีสะเกษ เขต 2		  ร.ร.ส้มป่อยพิทยาคม		  นายณัฐพล บัวพันธ์

สพท.นครศรีธรรมราช	 เขต 2	 ร.ร.ทุ่งใหญ่วิทยาคม		  นายจำนงค์ ชัยเพ็ชร

สพท.ลำปาง เขต 1		  ร.ร.แม่เมาะวิทยา		  นายสุวิทย์ โพธิศาสตร์

สพท.ชัยภูมิ เขต 1		  ร.ร.เมืองพญาแลวิทยา		 นายธีรยุทธ ศรีตระกูล

สพท.นครศรีธรรมราช เขต 2	 ร.ร.ฉวางรัชดาภิเษก		  นายบัญญัติ ศรีวิสุทธิ์
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